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WARNING

In the application of UTICOR Technology, LP programmable con-
trol devices, you should consider them components.  Therefore,
provisions other than the programmable control device must be
taken to protect personnel in the event of a programmable control
device malfunction.  Programmable control devices should not be
used as stand-alone protection in any application.  Unless proper
safeguards are used, unwanted start-ups could result in equipment
damage or personal injury.  If programmable controllers are used
with operator interface and like devices, this hazard should be of
primary importance.  The operator should be made aware of this
hazard and appropriate precautions should be taken.

In addition, consideration should be given to the use of an emer-
gency stop function that is independent of the programmable con-
troller.

The diagrams and examples in this user’s manual are included for
illustrative purposes only.  UTICOR Technology, LP cannot assume
responsibility or liability for actual use based on the diagrams and
examples.

1st printing — 10/97     Manual Number 79769-3

PGI 100 uWIN SOFTWARE
User�s Manual

CAUTION

Do not press the PGI 100 touch-
screen with any sharp objects.
This practice may damage the
unit irreparably.

© Copyright 1996–1997
All rights reserved
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Welcome to UTICOR Technology, L.P.’s  uWIN Programming Software for Windows.  uWIN is
a comprehensive graphics and interface program, for use with Windows 3.1 and higher, that
allows you to program the PGI 100 Power Panel.

The unique power of the uWIN programming software stems from its ability to create a total
operator interface program that is both easily understood by your operator and fully inte-
grated with your PLC.

GETTING STARTED
You have received your uWIN programming software on 3.5 inch
disks. These allow you to install the program onto your PC.

Place the disk labeled “Install Disk 1” into your Drive A.

From Windows Program Manager click onto the File pull-down menu
and click on Run. At the prompt type A:install and press the enter key.
Follow the onscreen prompts to load the software.

The install program selects C:\WINPGI
as the default directory (screen, upper
left).

For custom installation, you can select
the files that are loaded onto your sys-
tem. This includes selecting PLC files
(top).

Click onto the check mark to select the
file (left).

IMPORTANT!
During installation you will
be prompted to enter your
uWIN software registration
number.  The registration
number is affixed to the
inside cover of this manual.
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uWIN PGI Program Loader

Once the program has been installed you will have a new program
group listed in your Windows Program Manager. To run the program-
ming software double click on the uWIN icon. Once the software has
been initiated, you will see the start-up screen.

Start Project Selection

The Start Project Selection screen, shown below, helps you select a
project on which to work. This screen is only available when the
software is started. You can create a new project, open an existing
project, connect to a PGI to access a “remote project” or request help.
Choose one of the four options to begin.

NOTE:
To skip the �Start Project
Selection� screen, click
on the blue UTICOR sym-
bol or one of the PGI 100
symbols at the top of the
screen. This allows you
immediate access to the
Main Programming
Screen.
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Overview
The main purpose of the uWIN software is to program the PGI 100 to
meet the requirements of your application. This programming, as you
develop it, can be stored to your computer’s disk and/or to a PGI 100.
The programming developed for a PGI 100 consists of a number of
different parts that are collectively called a Project.

A Project, when stored to disk, is composed of a variable number of
disk files, all with the same base file name and with different file name
extensions. To delete or move a Project from Windows or DOS, you
must perform the operation on all of the files in that directory that have
Project’s base file name.

uWIN’s main menu begins with File in the left-most position. The
entities that can be opened, saved, printed, etc. from that menu are
actually Projects. The menu is titled File simply because most Win-
dows program menus begin with File.

Opening a Project

In order to begin, you must either open or create a project. To do this
select open existing project from the Start Project Selection screen
(previous page), or click on the File pulldown menu and then click on
Open.
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Creating a New Project

Select Create New Project from the Start-Up screen or select New from
the File menu. Select the Drive and Directory to place the project in the
proper location. Then, in the box titled Filename, type the name of the
project you are creating, click on OK. The following text outlines the
order of the screens that will appear when creating a new project.

Selecting the Project

Supplied with your software are several demonstration files.  The
project is located under the C:\winpgi directory. Click onto the file
demo_clr and click OK.  This allows access to the remaining options
under the File pull-down menu. The first programmed screen in the file
is displayed.
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Steps for creating a new project:

Selecting a PLC
Use the arrow to the right of the current PLC box to scroll the list of
available PLCs. Click on your choice and then click on the select
button. For more information on selecting a PLC see the Project Setup,
Programmable Logic Controller (PLC), Select PLC section of this
manual.

Selecting a Function Module
Use the arrow to the right of the current Function Module box to scroll
the list of available Function Modules. Click on your choice and then
click on the select button. For more information on selecting a Func-
tion Module see the Project Setup, Function Module section of this
manual.

PLC Attributes
This screen displays the attributes of the PLC or Function Module you
have selected above. For more information on individual PLC settings
refer to the PGI 100 to PLC Interfaces Manual (Part # 79751) or the
Project Setup, Programmable Logic Controller (PLC), PLC Attributes
section of this manual.

Function Module Attributes
This screen displays the attributes of the Function Module you have
selected above. For more information on individual Function Module
settings refer to the manufacturer’s manual or see the Project Setup,
Function Module, Function Module Attributes section of this manual.

Register Definitions
This allows you to edit and examine the internal register map and
specify the initial values for the registers. The internal register map
associates an internal register with a corresponding PLC or Function
Module address. Internal registers (16-bit) 1–1,024 may be mapped to
the PLC, and internal registers 1–2,048 may be mapped to a Function
Module. For more information see the Project Setup, Register Defini-
tions section of this manual.

System Attributes
There is a system attribute dialog box containing information on error
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Create or Select a Base Screen

In order to create a new base screen enter a
screen number in the Number box and the
new title in the Title box, then click on Select.
To select an existing screen, choose a file
from the Screen List and highlight the file you
want to open. Click on Select.

Viewing the Base Screen

This screen contains the Main Menu, which is
the starting point for all operations. It also
contains the editing and drawing icons along
the top of the screen. Selection boxes contain-
ing line color and type and fill color and type
are located at the bottom of the screen. The
number of bytes that can be added to this
screen, Free, and the current mouse position,
X: and Y:, are also shown at the bottom of the
window.

flags, time and date, power-up screen, alarm controls and auxiliary port
settings. For more information on system attributes see the Project
Setup, System Attributes section of this manual.

Display Options
Display options allow you to control the character size and direction of
text, the size of the grid, and many editing functions such as snap to
grid, draw fill, ortho, show fill points, show include points, show
trigger names and show triggers. This function also allows you to
select the display type you are using.  For more information see the
Options Menu, Display Preferences section of this manual.
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Onscreen Help

Included in your uWIN software package is a comprehensive help
system. To access, click on the Help pull-down menu in the upper right
corner of the screen and click on INDEX. If you need help on a particu-
lar screen, press the F1 key and this will access associated help screens
anytime while using the software.

Fly-Over Help

When the mouse cursor comes to rest over any toolbar or toolbox
button for a short while, a small yellow window will appear containing
a brief description of the function of that particular button. The window
will disappear as soon as the cursor has been moved off the button.
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The Main Programming Screen consists of:

File Menu Project functions.
Edit Menu Tools for editing graphics screens.
Screen Menu Screen functions.
Tools Menu ToolBox tools.
Draw Menu Triggers, include screens and drawing tools.
Remote Menu Remote project functions.
Options Menu Preferences and serial port setup.
Help Menu Help on uWIN software.
Line Color Drawing color selections.
Line Type Line type selection.
Fill Type Fill pattern selection.
Fill Color Fill foreground and background color selection.
Free The free memory for the displayed screen.
X and Y
 Coordinates The location of the mouse cursor on the screen.

INTRODUCTION
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FILE MENU
New/Open File

This allows you to open or create a new project.

To create a new project:
1. Select new from the File menu.

2. Enter up to an eight character name in the box titled Filename.
To change the location of the file, click on the Drive and
Directory selections until you reach the location you want the
file to reside. Click on OK.

To open an existing file:
1. Select the location (Drive and Directory) of the file you want

to open.

2. From the list of files, highlight the one to open. Click on OK.

Open Remote
The open remote option allows you to work directly (on-line) with a
PGI unit. All saved changes will be saved to the PGI memory and not
on your hard disk.

NOTE:
Another uWIN feature is the
Quick Pick list. The Quick
Pick list allows you easier
access to commonly used
files. uWIN saves the last
three files opened and dis-
plays them at the bottom
of the File menu. To open
one of these files simply
select it from the File menu.
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Save As...
Save As... allows you to
save the project under a
different name and
location on your hard
drive. The software will
not allow you to save to
the open file.

To save a file under a different name or location:
1. Choose Save As... from the File menu.

2. Enter a new Filename in the box provided and manipulate
the Drive and Directory to show the location the new file is
to be placed. Click on OK.

Save
This will save the current screen, but not the entire project. (The infor-
mation in the current project has already been saved, except for the
current screen.) The uWIN programming software prompts the user to
save any changes made before exiting that screen.

Remote Transfer

Upload File to Unit
This allows you to select a project to be loaded into the PGI 100. When
this is selected a dialog box similar to the open file dialog is shown.
The file to upload is selected from that dialog.

The Upload File to Unit pop-up windows
is displayed. Enable the aspects of the
project you wish to load by clicking on a
box to place an X next to your selections.

Download File from Unit
The download function allows you to load a project from the PGI 100
to your PC. Select the file to be downloaded and click OK. The internal
register map, file protection and passwords, PLC attributes, function
module attributes, system attributes, the initial values of the internal
registers and image screens are saved to disk.
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Verify File
The verify file menu item allows the project in the PGI 100 to be
verified to a project in your PC. The file must be selected from an
existing file list.

Project Setup

Annotation
The annotation functions provide a means for you to document the
programming you have completed on a PGI 100 project. You may
enter text to describe the entire project, each individual screen, and
each register. This text will be printed when the various parts of the
project are printed or it can be viewed with uWIN. The annotation is
only stored with the project on the computer’s disks and cannot be
stored or displayed by the PGI 100.

Filename
This function is only enabled when working on-line. It allows you to
select the name of a project on disk so that you can access its annota-
tion text in the Register Definitions function.

Program
This selection will cause the Edit Program Annotation screen to ap-
pear. Make the necessary program notations and select OK.

Screen Annotation
After selecting any of the
various screens: base, library,
symbol, linegraph, keypad,
report, alarms, messages, or
tonnage graph from the
annotation menu, the screen
to the right will appear. Select
the screen you wish to edit
and click on the Edit button at the bottom of the screen. (This dialog
box will also tell you the screens that have been created and those that
have annotation.)

The Edit Screen Annotation dialog will then appear. Using the mouse
place the cursor in the white editing area and make the necessary
notations.
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Function Module
This allows you to select a function module.  You must be off-line to
select a module.

To select a function module:
1. From the File menu, choose Project Setup > Function Module

> Select Function Module.
2. Click on the down arrow to view the different types of func-

tion modules.
3. To select a module, click on it once with your mouse and then

click on the Select button.

Function Module Attributes:
This screen displays a dialog box
specific to the type of function
module you have selected.  This
dialog box allows programming of
the direct transfer registers to be
moved between the Function
Module and the PLC that is
connected to the PGI. In the
illustration to the right the Pro-
grammable Limit Switch has been
selected.

NOTE:
 To select Function Modules
for the MF2 (multi-function
cradle), choose MF2 as
current module.  Go to the
Function Module Attributes
screen to select the Func-
tion Module  for each slot.
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Function Module Attributes MF2:

To select the Function
Module for each slot, click
on the slot you wish to
change (1-No Module, 2-No
Module), then click on the
Function Module you want
mapped there (PLS Pro-
grammable Limit Switch,
Peak Tonnage, Multi Turn
Decoder, etc.).  Now click
on the arrow button .

The group and unit numbers
are the group and unit
numbers of the MF2 and not
the PGI 100 PowerPanel.

You may also directly
transfer by clicking on the
Direct Transfer tab.

Register mapping for function modules is accomplished in the same
window used for PLC mapping and Register Initial Values definition
(Project Setup > Register Definitions). For more information, see
“Register Definitions,” this section.
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Palette Colors
Everything drawn on the PGI 100 is assigned a color number from 1 to
16. When you choose colors for drawing or filling while editing the
screens in the project, you are really assigning color numbers. The
Palette color selection dialog box is used to associate the colors a PGI
100 can display with those 16 color numbers.

The Color Choices column displays the colors that the currently
selected PGI 100 model can display. The PGI Palette column displays
the current set of colors chosen for the 16 color numbers. To change
the color for a given color number, select that color number with the
mouse from the PGI Palette column. Select the color to be assigned to
that number from the Color Choices column. Then press one of the
buttons between the columns to make the selection.

Each of the 16 color numbers can be a solid color or it can blink. To
make a color number blink, two different colors must be assigned to it
from the color choices column. The Blink On and Blink Off buttons
assign blinking colors. The solid color button assigns non-blinking
colors.

To select colors:

1. Select the color to be set
from the PGI Palette
column.

2. Select the color to be
assigned from the Color
choices column.

3. Press Solid Color, Blink
On or Blink Off buttons.

4. Repeat for more choices
or press Save Changes to
save the changes and exit
from the dialog.
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Programmable Logic Controller (PLC)

Select PLC
This allows you to select your Programmable Logic Controller (PLC)
as long as you are not on-line.

To select the PLC:
1. From the File menu, choose Project Setup > PLC > Select.
2. Click on the down arrow to view the different types of PLCs.
3. To select a PLC click on it once with your mouse and then

click on the Select button.

PLC Attributes
This screen displays the attributes of the type of PLC you have selected
above. (For more information on the individual PLC settings refer to
uWIN Help.)

The PLC’s Attributes allow you to
select the parameter pertaining to
your PLC. In the illustration at left,
we have selected the UTICOR
Director 6001.

The PLC Attributes pop-up win-
dow is contingent upon the PLC
selected in the Select PLC option.
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Protection

Set Protection Level (PGI 100 Password Protection)
uWIN programming software and exec supports four levels of protec-
tion. Level zero is the lowest while level three has the highest security.
Level zero does not require a password, while levels one through three
each have a separate password.

A password may be up to 12 characters long and may contain any
printable characters. Passwords are not case sensitive, for example,
“QWERTY” will match “qwerty.”

When changing to a higher protection level the user must enter the
correct password for the new level. If an incorrect password is entered
then an error will be displayed and the user will remain at the original
level. When changing to a lower protection level, the user does not
need to enter a password. The password protection may be disabled by
the user. The change password dialog has a checkbox to enable or
disable password protection. When protection is disabled, all the
program software functions and computer interface commands are
available to the user.

When passwords are entered they are not echoed. The user is required
to enter the password twice in order to verify it. In addition, the pass-
words are up or downloaded with the user program. They are cleared
and protection disabled when the unit is initialized. A separate PC
program (PASSWORD.EXE) is provided to set the passwords in the
PGI 100 regardless of its protection level.

NOTE:
Onscreen help is always
available when you are
using uWIN.  To get help,
press the F1 key and you
will access the associ-
ated help screens.
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Password Functions of the Protection Levels
Level 0
Open a file or connect to a PGI 100
Set up the serial port
About
Monitor Registers
Help
Level 1
Change register values
Display a screen on the PGI 100
Set the time and date
Send text to the PGI 100
Warm start the PGI 100
Level 2
Examine the project:
Select screens

Examine system attributes
Examine PLC attributes
Examine register definitions

Print screens
Verify file against the PGI 100:

Examine palette colors
Examine annotations

Changing Passwords
The change passwords function allows you to set and change pass-
words for the various levels of protection. Click onto the box right of
the level of protection and enter a password. You will be asked to
verify the new password once one has been entered.

In order for the password to be active, click on the Protection Enabled
option. By setting a password you are able to set various functions
available only to certain levels of password availability.  See the chart
above.

Important:  We recommend that you write down the passwords and
put them in a safe place. If a password is lost or forgotten, it cannot
be recovered!

Save as
Download file from the PGI 100
Get the alarm history and message log
Clear the alarm history and message log
Level 3
Edit project:

Save screens
Save system attributes
Save PLC attributes
Save register definitions
Save the palette

Edit annotations
Delete project
Upload PLC driver
Initialize the PGI 100
Upload project to the PGI 100
Program user FLASH
Read user FLASH
Test user memory in the PGI 100
Set passwords
Execute the boot program
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Register Definitions
The Register Definitions option allows you to examine and edit the
internal register map. The internal register map associates an internal
register with a corresponding PLC or Function Module address.
Before you enter mapping information for a register, you must use the
mouse to select whether the mapping is for a PLC, Function Module,
I/O Card, or PGI internal (no box checked). If none are selected, no
mapping will be allowed for that register. Both discrete and data
register addresses are supported.

If you select PLC, you can enter text into the mapping field for the
register.  If you select Function Module, you must use the Module
Mapping dialog box.  To acquire this dialog box, click on the “Module
Mapping” button or press the right mouse button. You may also select
I/O Card (for Input/Output Module), and then you must click on the
“I/O Mapping” button or press the right mouse button.

NOTE:
You should always use all
bits of one register before
mapping another. This en-
sures the PGI is running at
maximum speed. We rec-
ommend that registers be
used lowest to highest and
consecutively when pro-
gramming.

When you click on the “I/O Mapping” button, the “I/O
Selection” dialog box appears.  Select on Input or Output
and then click on the “Select” button. The I/O Cards require
more than one register to be mapped.  These will be auto-
matically mapped when the first register of the command is
mapped.  The mapping field will contain the word
“mapped” and the check boxes will be set to I/O Card.
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The module mapping
dialog box will be sup-
plied by the selected
function module
board’s DLL.  It will
present a list box with
the available com-
mands.  Click on one to
highlight it and then
click on the Select button.

Some Function Modules require more than one register to be mapped.
These will be automatically mapped when the first register of the
command is mapped.  The mapping field will contain the word
“mapped” and the check boxes will be set to Function Module.
Changes to the initial values and annotation will be allowed.

When using the MF2 (multi-function dual cradle), if you click on the
“Module Mapping” button, a dialog box appears where you will select
Slot 1 or Slot 2 and their respective — and previously selected —
Function Module.  After you have selected the slot, a “mapping com-
mand selection” dialog box appears for that particular Function Mod-
ule, supplied by the function module boards’s DLL.  Click on one to
highlight it and then click on the Select button.

When a multiple register command is being mapped for a PLC, it will
be refused if the required number of registers following the command
are not currently set to internal.  When a multiple register command is
being mapped for a Function Module, you will be asked if you want to
“Remove mapping for Register __?”  If you select OK, the mapped
register will be overwritten. When a multiple register command is
cleared, the reserved registers associated with it will be cleared as well.

The syntax for entering PLC addresses depends on the type of PLC.
However, most PLC address formats were modeled after how the
addresses were entered in the manufacturer’s PLC program software.
The Help button will display help specific to the selected PLC. The
PGI 100’s registers are set to the specified initial values during warm
starts, restarts or power-ups. You must enter a number in the Register
Initial Value that will be sent to the PGI Register every time the unit is
powered up or restarted.
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There are 1,024 16-bit internal registers that may be used for mapping
a PLC or Function Module.  Registers 1,025 through 2,048 may only
be used as internal registers or mapped to a Function Module. System
attributes and triggers monitor and write to the PGI registers, and the
PLC driver transfers the data between the corresponding PLC address.

The registers can be mapped
individually or in blocks. To
define a particular map block
press the Block button.

The block function allows you to
select up to 255 registers for PLC
interaction.

NOTE:
To avoid scrolling through all the registers  to
find the register number you want to map �
Click on the �Goto� button and  enter the
particular register number and you will auto-
matically be taken to that register .
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System Attributes
System Attributes represent the attributes that contribute to the con-
figuration of the PGI 100.

General

Power-up Screen
This is the base screen displayed after the unit completes its power-up
sequence. If the initial value of the “Switching Screen Internal” is
anything but zero, this entry will be ignored. Range is 1–999. If Power-
up Screen is set to zero and Switching Screen is set to zero, the PGI
will never display a screen.

Power-up Alarm Group
This specifies which alarm group will be monitored when the unit is
powered up. Range is 0–9.

Alarm Display Time (Sec.)
Specifies the length of time (in seconds 1–60) that an alarm will
remain displayed before the next alarm, in the circular queue, is dis-
played.

Alarm List Size
If more than one alarm is active they are placed on a circular queue and
displayed one after another. This parameter specifies the length of the
queue. Range is  1–99.

NOTE:
System Attributes may
be mapped to any inter-
nal register 1�2,048 �
but the PLC can only
read and write to regis-
ters 1�1,024.
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Display Saver
The length of time in minutes that passes before the screen saver is
activated. The timer is set when a new screen is displayed, or when the
screen is touched or an alarm is activated.

Enable Buzzer
This causes the PGI 100 touchscreen to beep when an active area of the
touchscreen is pressed. Click on NO to disable and YES to enable
sound.

Screen Security Code
Display screen triggers have an option which can require the operator
to enter a security code before allowing a screen to be displayed. The
1-10 digit number entered here is that security code.

Text Alignment Flag
This determines how text is stored in the PGI 100 registers.  Text is
stored 2 characters per register.  Click on MSB-LSB (Most Significant
Byte to Least Significant Byte) to store the first character in the high
byte and the second character in the low byte.  Click on LSB-MSB to
store the first character in the low byte and the second character in the
high byte.

Internal Registers

Switching Screen Internal
Enter an internal register number (1–2,048). This register can be written
to by the PLC to display a screen on the PGI 100. Entering a zero
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disables the function. This will allow the PLC to change Base Screens
at any time.

Current Screen Internal
Enter an internal register number (1–2,048). This command is read
only by the PLC. A zero disables the function. This allows the PLC to
know what screen is currently displayed.

Error Flag Internal
Enter an internal register number (1–2,048). The PGI places bits to
indicate errors that have occurred in the unit. This is read only by the
PLC. A zero disables the function. Reference the following table.

PLC Error Internal
This is an internal register, numbered 1–2,048, that the PGI 100 sets to
indicate which PLC errors have occurred. The bit values are product
specific. The PGI 100 does not read this register. A zero here will
disable the function.

Bit Number Description

0 RAM Error - indicates the system RAM test failed. Set/cleared on power-up.

1 Video RAM error - indicates the system RAM test failed.  Set cleared on power-up.

2
Low Battery - indicates battery for system RAM needs to be replaced.  Cleared on power-up, set
when low battery detected.

3
Invalid User Program - indicates the user program, system attributes, or initial register values are
corrupted.  Set/cleared on power-up and when an user program is uploaded to the unit.

4
Invalid Driver - indicates the PLC driver code or the PLC attributes are corrupted.  Set/cleared on
power-up and when a driver is uploaded to the unit.

5
LineGraph Buffer Overflow - indicates there are too many linegraph elements to monitor.
Set/cleared on power-up.  Set when a new linegraph or alarm screen is uploaded to the unit.

6
Alarm Buffer Overflow - indicates there are too many alarm elements to monitor.  Set/cleared on
power-up and when an user program or alarm screen is loaded.

7
Base Screen  Buffer Overflow - indicates the current base screen and its libraries and symbols
contain more data than the screen buffer can hold.  Set/cleared when switching screens.

8
Driver Error - indicates the PLC driver detected an error. Set/cleared by the driver every scan.
An error message will also be displayed when the bit is set.

9
Watchdog - this bit is toggled every five seconds allowing the PLC to determine the PGI is
communicating.

10-400 Keypad key entered.
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Function Module Error Internal
This is an internal register, numbered 1–2,048, that the PGI 100 sets to
indicate which function module errors have occurred. The bit values
are product specific. The PGI 100 does not read this register. A zero
here will disable the function.

Special Command #1 and #2 Internal
The specific command #1 and #2 fields can be used to specify two
different PGI 100 registers as “special command” registers. Values
placed in these registers will be interpreted by the PGI 100 as special
commands that are defined in the table below. Typically #1 is written
to by the PGI and #2 is written to by the PLC.

Command Number Instruction

0 No Command
1 Increment clock 1 hour
2 Decrement clock 1 hour
3 Turn buzzer on continuously
4 Turn buzzer off but not when screen is touched
5–14 Select alarm group 0–9
15 Clear alarm history
19 Clear message log
1000 Stop all linegraphs
1001–1999 Stop linegraph 1–999
2000 Restart all linegraphs
2001–2999 Restart linegraphs 1–999
3001–3999 Print report screen 1–999
4001–4999 Display report screen 1–999
5001–5999 Triggers alarms 1–999
6000 Clears all active alarms
6001–6999 Clears alarms 1–999

Year, Month, and Day Internal
Enter an internal register number (1–2,048). The PGI 100 sets the year,
month and day, respectively, from the real-time clock. A zero disables
the function. These are all separate registers.

Hour, Minute and Second Internal
Enter an internal register number (1–2,048). The PGI sets with the
hour, minute and second from the real time clock. A zero is disabled.
These are all separate registers.

NOTE:
The PGI will only react to the
commands when the value
has changed (e.g.:  to in-
crement the clock hour two
times, you must send a
value of one, then a value
of zero, then send a value of
one again.)
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Auxiliary Port Settings

Port Usage
Select the setting that allows the auxiliary port to print alarms, message
screens, alarm history screens, and report screens in ASCII. In addition,
you can set the parameters for connecting a bar code reader. If you
select Print you cannot Read Bar Code, and if you select Read Bar
Code you cannot Print.

Baud Rate
Select the baud rate that corresponds to the device chosen in the Port
Usage option.

Parity, Stop Bits, and Data Bits
Select the corresponding attributes of the device chosen in the Port
Usage option.

Contrast/Brightness Internal
Enter an internal register number (1–2,048).   A value entering in this
register will adjust the brightness or contrast of the display (i.e., the
higher the value the greater the brightness or the greater the contrast.)
The accepted value range is dependent upon the display type.  The
display type also dictates whether this registers controls the brightness
or controls the contrast.
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Select RS-485
This allows you to select RS-485 as the communication protocol. If
you are connecting RS-232 or RS-422 do NOT select this feature.

Require CTS
Select this to match the device chosen for the auxiliary port.

Control RTS
Select this to match the device chosen for the auxiliary port.

Bar Code Starting Register
Enter the number that will serve as the starting register of the bar code
reader data.

Number of Registers
This indicates the number of registers used by the bar code reader.
Each register holds two ASCII characters. There is a limit of 40 regis-
ters.

Print Report Screen Trailing Blank Lines
If you choose yes to this option additional carriage returns may be
printed after the text on a report screen. A total of 25 lines may be
printed. If you have only two lines of data the PGI will send 23 car-
riage returns.
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Print
The print program function allows you to print different sections of
your program.

Print Program Annotations
This causes the text entered through Project Setup > Annotation >
Program to be printed.

Print System Attributes
This prints the project’s system attributes.

Print Images
When selected, this takes you to the dialog box Image Print Ranges
(see next paragraph) where you may enter the range of screens you
wish to print.

Image Print Ranges
The Image Print Ranges screen allows you to select a range of screens
to print.  First — enter a number representing the first screen number
of the range.  Last — enter the number representing the last screen
number of the range.

Print Elements
This prints the elements associated with the programming screens,
including triggers.

Print Map
This prints the register mapping and initial values for the project.

Print Function Module Attributes
This prints the attributes set up for the selected Function Module.

Print PLC Attributes |
This prints the attributes set up for the selected PLC.

Print Cross References
This prints a list of PGI registers used in the project and the screen
numbers to which they are referenced. R = Read Trigger, W = Write
Trigger, Number = Base Screen Number. See example, following on
next page.
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Element Mapping References

1 I:013 R:2, W:2

2 O:014 R:4

3 BTR0701:3 W:2

4 I:05118 W:3, W:4

Example:

Merge
Merge allows you to merge screens from one program to another. For
example, if you have a base screen titled “Main Menu” and intend to
use it more than once, you can merge the screen into another file, this
could be your “library” of screens and objects, making it available
whenever you want to use it. UTICOR Technology, L.P.  supplies,
with the PGI 100 uWIN software, an additional library file containing
various symbols and icons. These range from buttons to data entry
panels. To use the file “library1” follow the procedures outlined.

Merge Copy
Merge Copy allows you to copy multiple screens from one project to
another. This example will show you how to create a file and merge it
with the supplied “library1” file.

1.  Go to the File Menu and select New. Create a project named
“Test” in the box titled Filename and select OK.

2. Return to the File Menu and select Merge. The File portion of
the Merge screen allows you to view the Open File, choose a
Secondary File, and select a direction for the files to merge.

3. Select a Secondary File, this is the file and path of the source
file. Choose “library1” as the secondary file that will be
merged into the primary file “test.” Library1 is a collection of
individual objects for you to use in your program.  In order to
view these screens they must be included onto a base screen.
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4. Select the screen type to be merged in this box. Select Library
for this example.

5. Enter the number of the First Source Screen that you want to
copy and the Last Source Screen that you want to copy. Select
number one for the first screen and nine for the last.

6. Enter the number of the First Destination Screen in which you
want the selected source screens to appear. Select number one
for this example.

7. Click on the Copy button. When the Merge is completed click
OK.

8. Click on the Screen Menu and Select Library. Here you see a
list of the different screens that were merged.

Merge Fill
The Merge Fill allows you to bring in a screen from one project and
copy it to consecutive screens in another project.

1. Go to the File Menu and open the file named “test.”

2. Return to the File menu and select Merge. Select “libraryl” as
the secondary file that will be merged into the primary file
“test.” Library1 is a collection of individual objects for you to
use in your program.  In order to view these screens they must
be included onto a base screen.

3. On the Fill portion of the Merge screen you will see four
options. First, select the Screen Type to be merged. Select
Library for this example.

4. Select the number of the Source Screen you want to copy.
Enter one for this selection.

5. Enter the number of the screen that will be the Start of Desti-
nation screen. Enter one for this selection.

6. Enter the number of the Last Destination screen that you wish
to Merge. Enter nine for this selection.
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OPTIONS MENU

Preferences

DISPLAY
Text
Character Size — Allows the user to select the height and width of the
characters.

Direction — Allows the user to select the direction of the character
strings. This can be set to be either horizontal or vertical.

Grid
Show Grid — The grid function is the display equivalent of graph
paper. Represented by a series of dots, it helps you align your drawings
and make them more precise. To enable the grid, check the box that
says Show. The dots do not appear on the PGI 100 display.

Grid Size — This function allows you to adjust the spacing between the
grid points. This can be adjusted to either character size, touchpad size
or user specified values.

Edit
Snap to Grid — Snap is a very useful function. It attaches lines, rect-
angles, circles and other drawn objects to grid points as they are drawn.
This is toggled on or off.

7. Click on the Fill button, when the Fill is completed click OK.

8. Click on the Screen Menu and Select Library. Here you should
see the same screen listed nine times.
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Draw Fill  — This option tells uWIN whether or not to draw fill when it
displays screens using that function. The screens will be drawn some-
what faster with fill disabled.

Ortho — The ortho tool allows lines to be drawn only horizontally or
vertically. The ortho function may be toggled on or off.

Show Fill Points — Fill points display the starting points of fill objects
used in the displayed screen. They are shown on the screen as an X.
This function may be toggled on or off.

Show Include Points — When this function is toggled on, it displays
an X for all of the “points of inclusion” for library, symbol, linegraphs
and keypad screens.

Show Trigger Names — The trigger names option displays the names
associated with triggers on the screen. This function is toggled on or
off.  Although the name of the trigger is displayed on the screen, it will
never appear on the PGI 100 screen.

Show Triggers — This function displays the area designated for trig-
gers used in a screen. It is toggled on or off. The trigger locations are
only displayed on the PC and will never appear on the PGI 100 screen.

Display Type
This allows you to select the type of PGI 100 display for which the
project is intended. For remote projects the PGI 100’s display type will
be shown and cannot be changed.

LEVEL
The Options > Preferences > Level menu item causes the User Pro-
gramming Level dialog box to be displayed. In it the user can choose
between Basic and Advanced Programming levels. In the Basic level a
number of uWIN functions are disabled. This is to allow operation of
uWIN without having to become familiar with all its capabilities. In the
Basic level only Base screens and Messages can be created. Only the
Toolbox objects are available for use in the Base screens. The File >
Project Setup > Palette Colors function is also disabled. In Advanced
user mode, all uWIN functions are enabled.
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Serial Port
Group and Unit Number
Many PGI 100’s can be networked together on a serial network. Each
PGI 100 is assigned an address, that is selected through the group and
unit fields. Up to 15 groups and 4096 units can be addressed.

Port
Select the communications port the PGI 100 is connected to on your
computer.

Baud Rate
Select the baud rate that matches the PGI 100.

Parity, Stop Bits, and Checksum
Select the attributes that match your computer to the PGI 100’s set-
tings.

Require CTS, Control RTS
Select the attributes that match your computer to the PGI 100.

TOOLBOX
When this preference is enabled the Toolbox will appear on the screen.
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STATUS BAR

Color
You can assign various colors to lines, rectangles, circles and text.
These represent the available colors for the displayed screen. If another
type of screen is selected, EL Color or EL Mono for example, the
colors will change accordingly.

To select a Color:
1. Click on the color indicator at the bottom left of the program-

ming screen. A menu indicating the available colors will be
displayed.

2. Click on the desired color.

Line Type
You can change the type of line selected. Simply choose the desired
line type and begin drawing.

To select the Line Type:
1. Click on the line indicator at the bottom of the main program-

ming screen. A menu indicating the available line types will
be displayed.

2. Click on the desired line type.

Fill Type
You can change the fill pattern for drawn objects. Simply choose the
desired pattern and click within the object to be filled. Your selection
will be used for any Filled Object command and Fill command.

To select a Fill Type:
1. Click on the pattern indicator at the bottom of the main

programming screen. A menu indicating the available patterns
will be displayed.

2. Click on the desired pattern.



2 Main Programming Screen

36           79769-3

uWIN Software Manual            UTICOR Technology, LP

Fill Color
You can assign various colors to the fill foreground and background.
These represent the available colors for the displayed screen.

To select a Fill Color:
1. Click on the left color indicator at the bottom of the Main

Programming Screen to indicate foreground color. The color
indicator on the right designates background color. A menu
indicating available colors will be displayed. If a solid pattern
is selected then only the foreground color is used.

2. Click on the desired color for the foreground and background.

Free
This number represents the amount of available memory (bytes) re-
maining for the current screen.

X and Y Coordinates
The X and Y coordinates represent the location of the cursor within the
PGI display screen.

TOOLS MENU
The Tools menu allows you to choose from several predefined pro-
gramming objects. The tools provide generic panel replacement func-
tions. The programming tools can be accessed from both the floating
ToolBox and the Tools menu.

All of the objects in the ToolBox have user defined frame types, line
and fill colors, and text. To use a ToolBox object, click on it with the
mouse. You will then be prompted to define the outline of the object on
the screen with the mouse. After that a dialog box will appear that
allows you to complete the definition of the object.

Hint:  You may use the arrow keys to move an object to a precise
location after it has been placed on the screen.  To do so, click on the
object to select it and then hold down the left mouse button and the
CONTROL key while pressing the arrow keys.
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Floating ToolBox

To make the ToolBox appear in the uWIN software,
click on Options > Preferences >ToolBox (from
Main Programming Screen). Clicking once on the
ToolBox selection will place a check next to the
name and the ToolBox icons will appear on the
screen. To disable the ToolBox, open the menu as
described above, and click once to deselect — the
check will disappear along with the icons on the
screen.

ASCII String Object
The ASCII String Object will allow you to display the ASCII charac-
ters from values stored in a block of registers.

How to create an ASCII String Object:

1. Click on the ASCII String Icon.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.)

3. Click, do not hold, the left mouse button.

4. Take note of the number and size of the characters you plan to
use.  This is important because you are actually creating the
frame around the ASCII characters at this time.

5. Drag the cursor down and right, then click to position the
second corner. The ASCII String object attribute menu should
now be displayed.

6. Click on the Monitor Bit entry field. This register bit is used
by the PGI to display in ASCII the values in a block of regis-
ters. When the bit is on, the text is displayed. When the bit is
off, the text disappears.

Label
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Pushbutton
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Button
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Button
Object
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7. Enter the register and bit (e.g..: 2/7 where 2 is the PGI register,
“/” is the register bit separator, and 7 is the bit to monitor in
register 2).

8. The Display state tells the PGI to display the text when the bit
is on or when it is off.

9. Click on Starting String Register entry field and enter the first
PGI register number in the block of registers you want the PGI
to read. These values will be displayed in ASCII.

10. Click on Number of Registers. Here you will define the total
number of registers in the block. Each register can handle 2
characters. The maximum number of registers in the block is
20.

11. Click on Text String Size. Set the height and width of the text.

12. Click on String Text Color and select the color of the text.

13. Click on String Background Color and select the color of the
background within the bottom half of the frame.

14. Click on the Label tab at the top of the menu.

15. Enter in text you want for a “Title” in the frame area. This will
be displayed above the ASCII string.

16. Click on Text Size. Set the height and width of the title.

17. Click on Text Color and select the color of the title.

18. Click on Background Color and select the color of the back-
ground within the top half of the frame.

19. Click on the Frame tab at the top. The Style sets up how the
frame will look, basic or 3-D. The Outline Color sets the inner
and outer rectangle line colors. Color1 sets the color for the
top and left sides of the rectangle and Color2 sets the right and
bottom colors, but only if you have selected a 3-D frame. If

Example of a Text String:

Text String = UTICOR

Register
Hex

Value ASCII

1 5554 UT

2 4943 IC

3 4F52 OR
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you have selected a basic frame, Color1 is used on all sides of
the frame.

20. Click OK.

Bar Graph Object
The Bar Graph Object will allow you to program a bar graph.

How to create a Bar Graph Object:

1. Click on the Bar Graph Icon.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.)

3. Click, do not hold, the left mouse button.

4. Take note of the direction and size you want your bar graph.
This is important because you are actually creating the bar
graph area now.

5. Drag the cursor down and right, then click to position the
second corner. The Bar Graph object attribute menu should
now be displayed.

6. Click on the Monitor Register entry field. The PGI monitors
the value in this register and plots the bar graph accordingly.

7. Enter a PGI register number (e.g., 3).

8. Click on Maximum Value. The PGI uses this value to calculate
the Bar Graph to full extension. The minimum value will
always be 0.

9. Click on Data Type entry field. This selects the data base that
the PGI will use to read the values.

10. Click on Bar Orientation. Here you select the direction that the
bar will grow as the register data increases.
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11. Click on Bar Fill Pattern. Select the pattern type you want for
the bar.

12. Click on Bar Fill Color 1. This sets one color for a selected
pattern type and Color2 sets the other color. If you have
selected a solid pattern, only Color1 is used.

13. Click on Scale tab at the top of the menu.

14. Click on Scale Text. This is the text that will be inserted along
side the length of the bar (e.g.: temp., PSI).

15. Click on Scale Text Size. Set the height and width of the scale
text.

16. Click on Scale Color and select the color you want for the
scale text.

17. Click on Number of Ticks. This sets how many tick marks you
want along side the bar graph. The software will automatically
space the ticks evenly.

18. Click on Total Digits. The PGI will display the minimum value
(always 0) along side the “bottom” of the bar and the maxi-
mum number along side the “top” of the bar. Select how many
digits you want displayed (e.g. if your Maximum Value is 999
enter 3, if your Maximum Value is 99.9 enter 3 and in the
Fractional Digits field enter 1).

19. Click on Number Text Size. Set the height and width of the
digits.

20. Click on Number Text Color and select the color of the digits.

21. Click on Background Color and select the background color
you want for the inside of the frame. Do not use the same
color as your selected bar color.

22. Click on the Frame tab at the top. The Style sets up how the
frame will look, basic or 3-D. The Outline Color sets the inner
and outer rectangle line colors. Color1 sets the color for the
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top and left sides of the rectangle and Color2 sets the right and
bottom colors only if you have selected a 3-D frame. If you
have selected a basic frame, only Color1 is used on all sides.

23. Click OK.

Alarm History Button
The Alarm History Button causes the displayed screen to be replaced
with the alarm history screen. From there, you can return to the base
screen.

How to create an Alarm History Button:

1. Click on the Alarm History Button Object Icon.

Important:  If you are going to use the Touch screen to activate this
trigger, you must place the cursor on a touch-cell grid point and draw
the button big enough to cover at least one touch-cell. One touch-cell
is 40 pixels X 40 pixels.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.)

3. Click, do not hold, the left mouse button.

4. Drag the cursor down and right, then click to position the
second corner.

5. The Alarm History Button object attribute menu should now
be displayed.

6. Confirm Trigger is used as a “safety-net.” If it is selected, the
PGI will display a pop-up confirming the selection of Yes or
No to activate the trigger.

7. Select the Trigger Source you want to activate the trigger.
Either the Touch-Cell, External Keypad, or both. Please note
that if you have selected Confirm Trigger and External Key-
pad only, use the “C” and “E” on the External Keypad to
select Yes or No confirmation.
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8. Click on the Label tab at the top of the menu.

9. Enter in the text you want for a “Title” in the object area.

10. Click on Text Size. This sets the height and width of the title.

11. Click on Text Color and select the color of the title.

12. Click on Background Color and select the color for the inside
of the button. This should be a different color than the text
color.

13. Click on the Button tab at the top. The Style sets up how the
frame will look — basic, 3-D or circular. The Outline Color
sets the inner and outer rectangle line colors. Color1 sets the
color for the top and left sides of the rectangle and Color2 sets
the right and bottom colors, but only if you have selected a 3-
D button. If you have selected a basic or circular button, only
Color1 is used on all sides.

14. Click OK.

Numeric Entry Button
This button will cause a defined keypad to be displayed for numeric
entry.

How to create a Numeric Entry Button:

1. Click on Numeric Entry Button Object Icon.

Important: You must place the cursor on a touch-cell grid point and
draw the button big enough to cover at least one touch-cell. One
touch-cell is 40 pixels X 40 pixels.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.)

3. Click, but do not hold, the left mouse button.
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4. Drag the cursor down and right, then click to position the
second corner. The Numeric Entry Button object attribute
menu should now be displayed.

5. Click on Write Register and enter the number of the PGI
register where you want the keypad accumulator data to go.

6. Click on Minimum Value. This is the low end set point. The
operator will not be allowed to enter a value lower than the
value in this field.

7. Click on Maximum Value. This is the high end set point. The
operator will not be allowed to enter a value higher than the
value in this field.

8. Click on Total Number of Digits. The PGI will display the
minimum value and the maximum number inside the pop-up
keypad. Select how many digits you want displayed. (e.g.: if
your maximum value is 999 enter 3. If your maximum value is
99.9 enter 3 and in the Fractional Digits field enter 1.)

9. Click on Data Type entry field. This selects what data base the
PGI will use to write the values.

10. Click on Operator Length. If you select Regular the data will
be written to the one register. If you select Long, the data will
be treated as a true 32 bit word, where the Write Register
number holds the most significant digits and the next contigu-
ous register the least significant digits.

11. Click on Display Format. This is where you set the display
format for the data.

12. Click on Numeric Text Size. This sets the height and width of
the value of the register on the inside bottom half of the entry
button.

13. Click on Numeric Text Color and select the color for the value
of the register on the inside bottom half of the entry button.
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Push Button
This button allows you to perform a write operation to a discrete
location. The Push Button is available in seven styles: Momentary On
or Off, Timed On or Off, Set On or Off, and Toggle.

How to create a Push Button:

1. Click on the Push Button Object Icon.

14. Click on Background Color and select the color of the inside
bottom of the entry button. This should be a different color
than what you selected for Text Color in step 13.

15. Click on the Label tab at the top of the menu.

16. Enter up to 20 characters for the “Title” you want in the object
area. This text will also be displayed on the top of the pop-up
keypad.

17. Click on Text Size. This sets the height and width for the title
on the top half of the entry button.

18. Click on Text Color and select the color of the title on the top
half of the entry button.

19. Click on Background Color and select the color for the inside
top of the entry button. This should be a different color from
the Text Color selected in step 18.

20. Click on the Button tab at the top. The Style sets up how the
button will look, basic or 3-D. The Outline Color sets the
inner and outer rectangle line colors. Color1 sets the color
for the top and left sides of the rectangle and Color2 sets the
right and bottom colors, but only if you have selected a 3-D
button. If you have selected a basic button, only Color1 is
used on all sides.

21. Click OK.
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Important: You must place the cursor on a touch-cell grid point and
draw the button big enough to cover at least one touch-cell. One
touch-cell is 40 pixels X 40 pixels.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.)

3. Click, do not hold, the left mouse button.

4. Drag the cursor down and right, then click to position the
second corner.

5. Click on Write Bit entry field and enter the PGI register num-
ber and bit you want to control (e.g.: 2/7 where 2 is the
PGI register, “/” is the register bit separator, and 7 is the bit
to monitor in register 2).

6. Click on Write Type and select how the bit will be controlled.
Momentary on will turn the bit on for as long as you touch the
button. Momentary off will turn the bit off for as long as you
touch the button.  Timed on or Timed off will turn the bit on or
off for a specified amount of time.  If you select either of these
the next field will be enabled, Timed Delay. In the Timed
Delay field enter the time you want the value to stay changed
in tenths of a second (from 0 to 255).  Toggle will change the
state of the bit every time the button is pressed. Set on will
latch the bit on and Set off will latch the bit off.

7. Click on the Label tab at the top of the menu.

8. Enter the text you want for a “Title” in the object area.

9. Click on Text Size. This sets the height and width of the title
text.

10. Click on Text Color and select the color of the title text.

11. Click on Background Color and select the color of the inside
of the button. This should be a different color than the Text
Color selected in step 10.
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12. Click on the Button tab at the top. The Style sets up how the
frame will look, basic, 3-D or circular. The Outline Color sets
the inner and outer rectangle line colors. Color1 sets the color
for the top and left sides of the rectangle and Color2 sets the
right and bottom colors, but only if you have selected a 3-D
button. If you have selected a basic, or circular button, only
Color1 is used on all sides.

13. Click OK.

Indicator Button
Indicator Button is similar to the Push Button, except the Indicator
Button allows you to specify a second discrete address. The state of
that element determines whether the button is displayed in the On or
Off state. The text and colors for the two states are user specified.

How to create an Indicator Button:

1. Click on the Indicator Button Object Icon.

Important:  You must place the cursor on a touch-cell grid point and
draw the button big enough to cover at least one touch-cell. One
touch-cell is 40 pixels X 40 pixels.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.)

3. Click, do not hold, the left mouse button.

4. Drag the cursor down and right, then click to position the
second corner.

5. Click on Write Bit entry field and enter the PGI register
number and bit you want to control (e.g.: 2/7 where 2 is the
PGI register, “/” is the register bit separator, and 7 is the bit to
monitor in register 2.)

6. Click on Write Type and select how the bit will be controlled.
Momentary on will turn the bit on for as long as you
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touch the button. Momentary off will turn the bit off for as
long as you touch the button. Timed on or Timed off will turn
the bit on or off for a specified amount of time.  If you select
either of these the next field will be enabled, Timed Delay.  In
the Timed Delay field, enter the time you want the value to
stay changed in tenths of a second (from 0 to 255). Toggle will
change the state of the bit every time the button is pressed. Set
on will latch the bit on and set off will latch the bit off.

7. Click on Monitor Bit entry field the and enter the PGI register
number and bit you want to monitor. This is the address the
PGI monitors to “indicate” what state the bit is in. Typically,
it will be the same address as the Write Bit. However, if you
are using a Momentary Write it’s best to use a different bit that
the PLC sets after it reads the Write Bit.

8. Click on Monitor Bit On tab at the top.

9. Type in the text you want displayed inside the button when the
bit is on.

10. Click on Text Size. This sets the title height and width.

11. Click on Text Color and select the color you want for the title.

12. Click on Background Color and select the color you want for
the inside of the button. This should be a different color than
the Text Color selected in step 11.

13. Click on Monitor Bit Off tab at the top.

14. Type in the text you want displayed inside the button when the
bit is off.

15. Click on Text Size. This sets the height and width of the title
text.

16. Click on Text Color and select the color of the title text.

17. Click on Background Color and select the color for the inside
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of the button. This should be a different that the Text Color
selected in step 16.

18. Click on the Button tab at the top. The Style sets how the
frame will look, basic, 3-D or circular. The Outline Color
sets the inner and outer rectangle line colors. Color1 sets the
color for the top and left sides of the rectangle and Color2
sets the right and bottom colors, but only if you have selected
a 3-D button. If you have selected a basic, or circular button,
only Color1 is used on all sides.

19. Click OK.

Change Screen Button
The Change Screen object will allow the PGI to change its display to
another base screen.

How to create a Change Screen Button:

1. Click on the Change Screen Object Icon.

Important:  You must place the cursor on a touch-cell grid point and
draw the button big enough to cover at least one touch-cell. One
touch-cell is 40 pixels X 40 pixels.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.)

3. Click, but do not hold, the left mouse button.

4. Drag the cursor down and right, then click to position the
second corner.

5. Click on Base Screen Number and type in the Base Screen
you wish to display when the button is pressed. Please note
that a value of “0” will call up the previously displayed base
screen.

6. Click on Protected Screen to and select Yes or No to determine
if the screen that you will change will be protected.  If yes, a
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dialog box will appear and ask for a security code.  The
security code is set up in System Attributes.

7. Click on Label tab at the top of the menu.

8. Type in the text you want displayed inside the button when the
bit is on.

9. Click on Text Size. This sets the height and width of the title
text.

10. Click on Text Color and select the color for the title text.

11. Click on Background Color and select the color for the inside
of the button. This should be a different color than that se-
lected for Text Color in step 9.

12. Click on the Button tab at the top. The Style sets up how the
frame will look — basic, 3-D or circular. The Outline Color
sets the inner and outer rectangle line colors. Color1 sets the
color for the top and left sides of the rectangle, and Color2
sets the right and bottom colors only if you have selected a 3-
D button. If you have selected a basic, or circular button, only
Color1 is used on all.

12. Click OK.

Recipe Button
The Recipe button allows you to write values to several registers at
once.

How to create a Recipe Button:

1. Click on the Recipe Button Object Icon.

Important:  You must place the cursor on a touch-cell grid point and
draw the button big enough to cover at least one touch-cell. One
touch-cell is 40 pixels X 40 pixels.

2. Position the cursor on the desired location. (It’s best to start
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with the top/left corner and drag down/right.)

3. Click, do not hold, the left mouse button.

4. Drag the cursor down and right, then click to position the
second corner.

5. Click on Write Register entry field and enter the first PGI
register number you want to write a value to.

6. Click on Data Type entry field. This selects the data base the
PGI will use to write the values.

7. Click on Write Values. This is where you will enter the values
to be written to the PGI registers. The first field is the register
number you entered in the Write Register field. The seconden-
try field is the value you want written to in the next contiguous
PGI register, up to 20 registers. Confirm Write is used as a
“safety-net.” If it is selected, the PGI will display a pop-up
window confirming the selection of Yes or No to activate the
trigger. Select the Trigger Source that you want to activate the
trigger. Either the Touch-Cell, External Keypad, or both.  Take
note that if you have selected Confirm Trigger and External
Keypad only, use the “C” and “E” on the External Keypad to
select Yes or No confirmation.

8. Click on Label tab at the top of the menu.

9. Type in the text you want displayed inside the button when the
bit is on.

10. Click on Text Size. This sets the height and width for the title
text.

11. Click on Text Color and select the color for the title.

12. Click on Background Color and select the color for the inside
of the button. Use a different color than what you selected for
Text Color in step 11.
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13. Click on the Button tab at the top. The Style sets up how the
frame will look, basic, 3-D or circular. The Outline Color
sets the inner and outer rectangle line colors. Color1 sets the
color for the top and left sides of the rectangle, and Color2
sets the right and bottom colors only if you have selected a 3-
D button. If you have selected a basic, or circular button,
only Color1 is used on all.

14. Click OK.

Register Button
The Register button is used to write a constant to an internal register,
along with performing math functions with that constant.

How to create a Register Button:

1. Click on the Register Button Object Icon.

Important:  You must place the cursor on a touch-cell grid point and
draw the button big enough to cover at least one touch-cell.  One
touch-cell is 40 pixels X 40 pixels.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.)

3. Click, do not hold, the left mouse button.

4. Drag the cursor down and right, then click to position the
second corner.

5. Click on Write Register entry field and enter the first PGI
register number you want to write a value to.

6. Click on Write Type field. This selects what function type the
PGI will use to write the values. Set will write the value that is
entered in the Write Value field. Add will add the value that is
entered in the Write Value field to the current value in the
Register. Subtract will subtract the value that is entered in the
Write Value field from the current value in the Register.
Multiply will multiply the value that is entered in the Write
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Value field to the current value in the Register. Divide will
divide the value that is entered in the Write Value field by the
current value in the Register. AND will logic AND the value
that is entered in the Write Value field to the current value in
the Register. OR will logic OR the value that is entered in the
Write Value field to the current value in the Register. XOR will
logic XOR the value that is entered in the Write Value field to
the current value in the Register.

7. Click on Operator Length. If you select Regular the data will
be written to the one register. If you select Long, the data will
be treated as a true 32 bit word, where the Write Register
number holds the most significant digits and the next contigu-
ous register the least significant digits.

8. Click on Label tab at the top of the menu.

9. Type in the text you want to be displayed inside the button
when the bit is on.

10. Click on Text Size. This sets the height and width of the title
text.

11. Click on Text Color and select the color for the title text.

12. Click on Background Color and select the color for the inside
of the button. This should be a different color than the Text
Color selected in step 11.

13. Click on the Button tab at the top. The Style sets up how the
frame will look, basic, 3-D or circular. The Outline Color
sets the inner and outer rectangle line colors. Color1 sets the
color for the top and left sides of the rectangle, and Color2
sets the right and bottom colors only if you have selected a 3-
D button. If you have selected a basic, or circular button, only
Color1 is used on all.

14. Click OK.
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Report Screen Button
The Report Screen button when pressed will cause the displayed
screen to be replaced with the specified report screen. From there, you
can return to the base screen and print the report.

How to create a Report Screen Button:

1. Click on the Report Button Object Icon.

Important:  You must place the cursor on a touch-cell grid point and
draw the button big enough to cover at least one touch-cell. One
touch-cell is 40 pixels X 40 pixels.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.)

3. Click, do not hold, the left mouse button.

4. Drag the cursor down and right, then click to position the
second corner.

5. Click on Report Screen entry field and type in the Report
Screen you want to control when the button is pressed. If
Display Report When Triggered is selected, the Report Screen
number in the Report Screen entry field will be displayed
when the button is pressed. If Print Report When Triggered is
selected, the text of the Report Screen number in the Report
Screen entry field will be printed out the Aux. port of the PGI
when the button is pressed. Confirm Trigger is used as a
“safety-net.” If it is selected the PGI will display a pop-up
confirming the selection of Yes or No to go ahead and activate
the trigger. If Send to Slave is selected, the text of the Report
Screen number in the Report Screen entry field will be sent
out to UTICOR Message Displays from the Com2 port of the
PGI when the button is pressed. Group & Unit refers to the
addressing scheme of UTICOR Slave Displays. Select the
Trigger Source you want to activate the trigger. Either the
Touch-Cell, External Keypad, or both.
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Step Switch Button
The Step Switch object simulates a mechanical step switch on the PGI
100. The Step Switch allows you to simultaneously monitor and con-
trol two, three and four different bits and display ON and OFF text for
each bit. Each time you touch the step switch on the screen, you will
cycle the bits one at a time from OFF to ON.

The button is divided into horizontal slices, one for the legend and one
for each specified bit to be controlled. The rectangle has an user speci-
fied legend and both on and off colors for each of the controlled bits.

Please note that if you have selected Confirm Trigger and
External Keypad only, use the “C” and “E” on the External
Keypad to select Yes or No confirmation.

6. Click on Label tab at the top of the menu.

7. Type in the text you want to be displayed inside the button
when the bit is on.

8. Click on Text Size. This sets the height and width of the title
text.

9. Click on Text Color to select the color of the title text.

10. Click on Background Color and select the color for the inside
of the button. Use a different color other than what you se-
lected in step 9.

11. Click on the Button tab at the top. The Style sets how the
frame will look, basic, 3-D or circular. The Outline Color sets
the inner and outer rectangle line colors. Color1 sets the color
for the top and left sides of the rectangle, and Color2 sets the
right and bottom colors only if you have selected a 3-D but-
ton. If you have selected a basic, or circular button, only
Color1 is used on all.

12. Click OK.
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How to create a Step Switch Button:

1. Click on the Step Switch Button Object Icon.

Important:  You must place the cursor on a touch-cell grid point and
draw the button big enough to cover at least one touch-cell. One
touch-cell is 40 pixels X 40 pixels.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.) Make note of
how many and the size of characters you plan to use. This is
important because you are now actually creating the frame
around the characters.

3. Click, but do not hold, the left mouse button.

4. Drag the cursor down and right, then click to position the
second corner.

5. Click on Number of Steps. This sets up the number of steps
you wish to toggle through.

6. Click on Step 1 tab at the top of the menu.

7. Click on Monitor Bit entry field. Enter the Register and Bityou
want to set and monitor (e.g.: 2/7 where 2 is the PGI register,
“/” is the register bit separator, and 7 is the bit to
monitor in register 2). The PGI monitors this address and
displays either the on state text or off state text at this time.

8. Click on the On State Text field. The text typed here will be
displayed when the Monitor Bit is on.

9. Click on Text Size. This sets the height and width of the “on”
text.

10. Click on Text Color and select the color for the “on” text.

11. Click on Background Color and select the color for this step’s
section of the button when the bit is “on.”  This should be a
different color from the Text Color selected in step 10.
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12. Click in the Off State Text field. The text typed here, will be
displayed when the Monitor Bit is off.

13. Click on Text Size. This sets the height and width of the “off”
text.

14. Click on Text Color and select the color for the “off” text.

15. Click on Background Color and select the color for this step’s
section of the button when the bit is “off.” This should be a
different color than what you selected for Text Color in step
14. Repeat the above for the other steps you want to use.

16. Click on Label tab at the top.

17. Type in the text you want displayed in the top section of the
button.

18. Click on Text Size. This sets the height and width of the title
text.

19. Click on Text Color and select the color for the title text.

20. Click on Background Color and select the color for the top
section of the button. This should be a different color than
what you selected for Text Color in step 19.

21. Click on the Button tab at the top. The Style sets up how the
frame will look, basic or 3-D. The Outline Color sets the inner
and outer rectangle line colors. Color1 sets the color for the
top and left sides of the rectangle, and Color2 sets the right
and bottom colors only if you have selected a 3-D button. If
you have selected a basic button, only Color1 is used on all.

22. Click OK.
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Clock Object
The Clock object will display the current time and date of the PGI
100’s real time clock.

How to create a Clock Object:

1. Click on the Clock Object Icon.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.) Please note that
if you want to display both time and date you will need an
area at least 40 pixels high and 160 pixels wide.

3. Click, do not hold, the left mouse button.

4. Drag the cursor down and right, then click to position the
second corner. The Clock Object menu should now be dis-
played.

5. Click on Display field and select what you want displayed.

6. Click on Text Size. This sets the height and width of the clock
text.

7. Click on Text Color and select the color for the clock text.

8. Click on Background Color and select the color for the top
section of the button. This should be a different color from
what you selected for Text Color in step 7.

9. Click on the Frame tab at the top. The Style sets up how the
frame will look, basic or 3-D. The Outline Color sets the
inner and outer rectangle line colors. Color1 sets the color for
the top and left sides of the rectangle, and Color2 sets the
right and bottom colors only if you have selected a 3-D
button. If you have selected a basic button, only Color1 is
used on all.

10. Click OK.
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Label Object
The Label object allows text to be placed on the screen surrounded by a
box.

How to create a Label Object:

1. Click on the Label Object Icon.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right) Please note that
this is not a trigger, it’s just text with a frame around it so it
may be placed anywhere on the screen.

3. Click, do not hold, the left mouse button.

4. Drag the cursor down and right, then click to position the
second corner. The Label Object menu should now be dis-
played.

5. Click on the Text field and type what you want displayed
inside the frame.

6. Click on Text Size. This sets the height and width of the text.

7. Click on Text Color and select the color of the text.

8. Click on Background Color and select the color for the inside
of the button. This should be a different color other than what
you selected for Text Color in step 7.

9. Click on the Frame tab at the top. The Style sets up how the
frame will look, basic or 3-D. The Outline Color sets the inner
and outer rectangle line colors. Color1 sets the color for the
top and left sides of the rectangle, and Color2 sets the right
and bottom colors only if you have selected a 3-D button. If
you have selected a basic button, only Color1 is used on all.

10. Click OK.
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Message Object
The Message object is used to display messages within its frame on a
base screen. A user defined register is used to select the number of the
message to be displayed. The register can be used as discrete bits to
select 16 messages or the register’s value can be used to index between
255 different messages.

The Message object dialog box provides a table where the register
values can be mapped to message numbers, and the text size and colors
for the message display are defined. Other fields allow specification of
the registers to be used as “data sets” within the messages. No message
is displayed if the register is set to zero.

How to create a Message Object:

1. Click on the Message Object Icon.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.) Please note that
this is not a touch trigger area — it is just a frame, so it may be
placed anywhere on the screen. Also, at this time, take note of
the number and size of the characters you plan to use. This is
important because you are now creating the frame around
these characters.

3. Click, do not hold, the left mouse button.

4. Drag the cursor down and right, then click to position the
second corner. The Message Object menu should now be
displayed.

5. Click on Monitor Register and enter the PGI register you want
to monitor.

6. Click on Register Format. This is where you set up how the
PGI interprets the data in the monitored register. Word is read
as unsigned decimal (binary) and Bit format is read as each bit
displaying a message.

7. Click on Variable Data Register field (1). Enter in a PGI



2 Main Programming Screen

60           79769-3

uWIN Software Manual            UTICOR Technology, LP

Register number — the PGI reads the data in this register and
displays it within the message text. Note that there are control
characters that need to be programmed in the Message Screen
to display the data. Regular or Long — if you select Regular
the data will be read from one register — if you select Long,
the data will be treated as a true 32 bit word, where the entered
Register number holds the most significant digits and the next
contiguous register the least significant digits.

8. Click on Messages tab at the top of the menu.

9. Click on the first Message Number field. Enter the message
number you want displayed, printed, or logged when either the
register value equals the number or the bit is on.

10. Click on Text Size. This sets the height and width of the
message text.

11. Click on Text Color and select the color for the message text.

12. Click on Background Color and select the color for the inside
of the frame. This color should be different from the color you
selected for Text Color in step 11.

13. Repeat for each message.

14. Click on the frame tab at the top. The Style sets up how the
frame will look, basic or 3-D. The Outline Color sets the inner
and outer rectangle line colors. Color1 sets the color for the
top and left sides of the rectangle, and Color2 sets the right
and bottom colors only if you have selected a 3-D button. If
you have selected a basic frame, only Color1 is used on all.

15. Click OK.
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Numeric Object
The Numeric object monitors the value in a register.

How to create a Numeric Object:

1. Click on the Numeric Object Icon.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.)  At this time,
take note of the number and size of the digits you plan to use.
This is important because you are now creating the frame
around the digits.

3. Drag the cursor down and right, then click to position the
second corner.

4. Click on Monitor Register entry field and enter the first PGI
register number you wish to read a value from.

5. Click on Total Digits. Select how many digits you want
displayed (e.g. if your maximum value is 999 enter 3, if your
maximum value is 99.9 enter 3, in the Fractional Digits field
enter 1.)

6. Click on Data Type entry field. This selects the data base the
PGI uses to display the values.

7. Click on Operator Length. If you select Regular the data will
be read from one register. If you select Long, the data will be
treated as a true 32 bit word, where the Monitor Register
number holds the most significant digits and the next contigu-
ous register the least significant digits.

8. Click on Display Format. This is where you set the display
format of the data.

9. Click on Numeric Text Size. This sets the height and width for
the value of the register on the inside bottom half of the entry
button.
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10. Click on Numeric Text Color and select the color for the value
of the register on the inside bottom half of the frame.

11. Click on Background Color and select the color of the inside
bottom of the frame. This color should be different than the
color you selected for Numeric Text Color in step 10.

12. Click on Label tab at the top.

13. Type in the text you want displayed inside the top part of the
frame.

14. Click on Text Size. This sets the height and width of the title.

15. Click on Text Color and select the color of the title text.

16. Click on Background Color. Select the color for the inside top
of the frame. This color should be different than the color you
select for Text Color in step 15.

17. Click on the Frame tab at the top. The Style sets up how the
frame will look, basic or 3-D. The Outline Color sets the inner
and outer rectangle line colors.  If you have selected 3-D
Color1 sets the color for the top and left sides of the rectangle,
and Color2 sets the right and bottom colors only if you have
selected a 3-D button. If you have selected Basic, only Color1
is used on all.

18. Click OK.
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Pilot Light
A Pilot Light requires a discrete variable that will be monitored to
determine whether to display the ON or OFF state, text and colors.

How to create a Pilot Light Object:

1. Click on Pilot Light Object Icon.

2. Position the cursor on the desired location. (It’s best to start
with the top/left corner and drag down/right.) Take note of the
number and size of the characters you plan to use. This is
important because you are now actually creating the frame
around the characters.

3. Click, do not hold, the left mouse button.

4. Drag the cursor down and right, then click to position the
second corner.

5. Click on Monitor Bit entry field. Enter the Register and Bit
you want to set and monitor (e.g.: 2/7 where 2 is the PGI
register, “/” is the register bit separator, and 7 is the bit to
monitor in register 2.) The PGI monitors this address and
displays either the on state text or off state text and button.

6. Click on the Monitor On Bit tab at the top. The text typed
here will be displayed when the Monitor Bit is on.

7. Click on Text Size. This sets the height and width of the “on”
text.

8. Click on Text Color and select the color for the “on” text.

9. Click on Background Color and select the color for the button
when the bit is on. This color should be different than the Text
Color you selected in step 8.

10. Click on the Monitor Off Bit tab at the top. The text typed
here will be displayed when the Monitor Bit is off.
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11. Click on Text Size. This sets the height and width of the “off”
text.

12. Click on Text Color and select the color for the “off” text.

13. Click on Background Color and select the color for the button
when the bit is off. This color should be different than the Text
Color you selected in step 12.

14. Click on the Frame tab at the top. The Style sets up how the
frame will look — basic or 3-D. The Outline Color sets the
inner and outer rectangle line colors.  If you have selected 3-D
Color 1 sets the color for the top and left sides of the rect-
angle, and Color 2 sets the right and bottom colors only if you
have selected a 3-D button. If you have selected a basic or
round button, only Color 1 is used on all sides.

15. Click OK.

DRAW MENU

Triggers
Triggers are used to allow operator input and to select how data will be
displayed. They are used to assign various points on the screen where
information can be entered and displayed. There are several types of
triggers that can be incorporated into your program.  Triggers use the
PGI’s internal registers that may be mapped to PLC or Function Mod-
ule addresses.

Triggers are identified by a one to thirty-two character name. The
trigger names are only displayed while the screen is being edited.
While the trigger name is displayed, it is preceded by a three character
prefix. This prefix is indicative of the trigger type. For example, the
trigger name “LIB:button” represents a library trigger named “button.”
Triggers can only be edited or created from a base screen, although
some can be used in a report screen.
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Trigger Operation
Triggers that operate from the touchscreen are activated by pressing the
touchscreen area identified as part of the trigger. The area can also be
used by several different triggers, allowing one touch to activate a
variety of functions. It is important that you remember that the area
that has been named as trigger is not displayed on the PGI 100, but
rather operates as the trigger designates. Trigger names are for the
programmer’s benefit and are not displayed on the PGI 100. The names
are upper and lower case sensitive, so there can be different triggers
named “Button” and “button.”

Trigger Types
Triggers can be used for various tasks when developing your program.
In this section, information is provided on the triggers listed below:

Add Constant (ADD:) Message Screen (MSG:)
Alarm History (AHS:) Numeric (NUM:)
Analog (ANL:) PLS (PLS:)
Bar Graph (BAR:) Radio Button (RAD:)
Bit Text (BTX:) Recipe (RCP:)
Bit Write (BIT:) Register Write (REG:)
Clock (CLK:) Report Screen (RPT:)
Display Screen (DIS:) Scaled Keypad (SKP:)
Jump (JMP:) Scaled Numeric (SNU:)
Keypad (KYP:) Symbol (SYM:)
Library Screen (LIB:) Text String (TXT:)

Trigger Name
Screen ⇒
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Add Constant Trigger (ADD:)
This trigger adds an user defined constant to a register when the trigger
area is touched. The trigger allows you to specify a register, its type
(unsigned/signed decimal, BCD, octal or hexadecimal) and its size (16
or 32 bits). You can specify the constant value and whether it is to be
added or subtracted. A field also allows a limit value to be specified.

How to create an ADD Constant Trigger:

1. Click on Trigger under the Draw menu.

2. Click on Trigger Name and type in a new name for your
trigger, then click Edit.

3. Select ADD Constant and click OK.

4. You now need to make your selections in the following data
boxes:
Write Register:  your constant will be added or subtracted
from this register.
Operation: determines whether you add or subtract the
constant from the register.
Add Value: the constant that will be used in the operation.
Value Limit:  the limit that a register can contain. The
register maintains an upper limit for add and a lower limit for
subtract.
Data Type: allows you to select which data type the other
register will be.
Operator Length:  allows you to select a 16 or 32 bit register.
Confirm Write:  selects whether you want the trigger to
provide you with a confirmation request before it executes its
function.
Trigger Source: determines if this trigger is activated by an
area on the touch screen, an external keypad, or both. If you
select external keypad, you need to select which of the 16
function keys will be used to activate this trigger.

5. Click on Area and place the trigger name on the screen by
clicking once on the chosen location.
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6. Click to mark the location on the screen you want to specify as
the trigger location. Drag the mouse to the opposite corner and
click again to finish the trigger placement. The trigger is now
set.

Alarm History Trigger (AHS:)
The Alarm History trigger allows you to display the Alarm History
Screen. A maximum of 64 alarms will be included. Alarms are displayed
with the most recent being first.

How to create an Alarm History Trigger:

1. From the Draw menu click on Trigger.

2. Click on Trigger Name and enter your new trigger name, then
click on Edit.

3. Click on Alarm History Trigger and click OK.

4. You now need to make your selections in the following data
boxes:
Confirm Write:  selects whether you want this trigger to
provide you with a confirmation request before it executes its
function.
Trigger Source: determines if this trigger is activated by an
area on the touch screen, an external keypad, or both. If you
select external keypad, you need to select which of the 16
function keys will be used to activate this trigger.

5. Click on Area and place the trigger name on the screen by
clicking once on the chosen location.

6. Click to mark the location on the screen you want to specify as
the trigger location. Drag the mouse to the opposite corner and
click again to finish the trigger placement. The trigger is now
set.
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Analog Trigger (ANL:)
The Analog Trigger is used to display an analog gauge (e.g., a speed-
ometer).  The Analog Trigger simulates meters.  It displays a needle
that sweeps through an arc as the register value changes.  You can
specify the direction of the sweep for increasing values and tick marks
are displayed along the arc.

How to create an Analog Trigger:

1. From the Draw menu click on Trigger.

2. Click on Trigger Name and enter your new trigger name, then
click on Edit.

3. Click on Analog Trigger and click OK.

4. Make your selections or enter the appropriate settings in the
following data boxes under the “General”  tab:

Monitor Register:  the register that the analog will monitor.

Minimum Value/Maximum Value:  the lowest and highest
value that the analog can represent.

Data Type:  determines the form the data will take in the
monitored register.

Data Size:  determines the size the data will use in the moni-
tored register (regular or long).

Radius, Start Angle, Number of Degrees, Direction:  this
trigger displays a needle that sweeps through an arc as the
register value changes — make your selections or entries in
these data boxes to create your analog meter.

5. Click on the “Display”  tab and control the appearance of your
analog trigger display. Select the Needle Color, Number of
Ticks, Tick Length, Tick Color  and whether or not you want
a Display Outline.
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6. Click on the “Fill”  tab and select the Fill Pattern , Fill Fore-
ground Color and Fill Background Color  for your display.

7. Click on the Area button and place the trigger name on the
screen by clicking once on the chosen location.

8. Click to mark the location on the screen you want to specify as
the trigger location.  Drag the mouse to the opposite corner
and click again to finish the trigger placement.  The trigger is
now set.

Bar Graph Trigger (BAR:)
The Bar Graph trigger is used to display register values in the form of a
bar graph. The user can specify the height and width by placement on
the screen. The trigger has a register, data type (signed/unsigned deci-
mal, hex, octal, or BCD), a shading pattern, direction of bar movement
(up/down, left/right), maximum data value, and base screen location.

How to create a Bar Graph Trigger:

1. Click on Trigger under the Draw menu.

2. Click on Trigger Name and type in a new name for your
trigger, then click Edit.

3. Select Bar Graph and click OK.

4. You now need to make your selections in the following data
boxes:
Monitor Register: the register that the bar graph will monitor.
Maximum Value: the highest value that the bar graph can
represent.
Grow in Direction:  allows you to select whether the bar
graph goes up, down, left or right.
Data Type: determines the form the data will take in the
monitored register.
Fill Pattern:  allows you to select a pattern for the bar graph.
Fill Foreground Color:  if you have a fill pattern selected
this will be the foreground color.
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Fill Background Color: if you have a fill pattern selected this
will be the background color.

5. Click on Area to accept your choices and begin to place the
bar graph.

6. Click once to place the trigger name.

7. Click to mark the location on the screen where the bar graph
will be located. Drag the mouse to the opposite corner and
click again to finish the placement. The trigger is now set.

Bit Text Trigger (BTX:)
The Bit Text trigger monitors a discrete address and displays a text
string when the bit is on and a different one when the bit is off. A
typical use is to monitor a limit switch and display text that reads
“part is in position” when the bit is on and “part is not in position”
when the bit is off.

How to create a Bit Text Trigger:

1. Click on Trigger under the Draw menu.

2. Click on Trigger Name and type in a new name for your
trigger, then click Edit.

3. Select Bit Text and click OK.

4. You now need to make your selections in the following data
boxes:
Monitor Bit:  the bit in the PGI’s register that the trigger will
monitor.
Bit ON String:  the text that will be displayed on the PGI
when the bit is on.
Bit OFF String:  the text that will be displayed on the PGI
when the bit is off.
Character Size: allows you to select the size of the text as it
will appear on the PGI.
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Color:  allows you to select the color of the text as it will
appear on the PGI.

5. Click OK.

6. Click once to place the name of the trigger on the base screen.

7. Click to mark the location on the screen where the bit text
trigger will be located.  Drag the mouse to the opposite corner
and click again to finish the placement. The trigger is now set.

Bit Write Trigger (BIT:)
The Bit Write trigger controls the state of an element when a screen
area is touched. There are seven different options for the controlled
element: Momentary On, Momentary Off, Timed On, Timed Off,
Toggle, Set On and Set Off.

The user can set the Confirm Write option to yes or no, and select a
Trigger Source. The source can be a touch screen, an external keypad
or both.

How to create a Bit Write Trigger:

1. Click on Trigger under the Draw menu.

2 Click on Trigger Name and type in a new name for your
trigger, then click Edit.

3. Select Bit Write and click OK.

4. You now need to make your selections in the following data
boxes:
Momentary On or Momentary Off:  as long as you are
pressing the touch screen the bit will be on or off, respectively.
Timed On/Timed Off:  allows you to set the time that the bit
will remain on or off.
Timed Delay:  only available if timed on or timed off is
selected, this allows you to enter in tenths of a second (0–255)
a specified amount of time that the value stays changed.
Toggle: each time you press the touch screen the bit will
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Clock Trigger (CLK:)
The Clock trigger displays the time and date.

How to create a Clock Trigger:

1. Click on Trigger under the Draw menu.

2. Click on Trigger Name and type in a new name for your
trigger, then click Edit.

3. Select Clock and click OK.

4. You now need to make your selections in the following data
boxes:
Character Size: allows you to select the size of the text as it
will appear on the PGI.

toggle to the opposite state.
Set ON: if the bit is off it is turned on, if the bit is already on
it is left on.
Set OFF: if the bit is on it is turned off, if the bit is already off
it is left off.
Confirm Write:  selects whether you want the trigger to
provide you with a confirmation request before it executes
its function.
Trigger Source: determines if this trigger is activated by an
area on the touch screen, an external keypad, or both. If you
select external keypad, you need to select which of the 16
function keys will be used to activate this trigger.

5. Click on Area and place the trigger name on the screen by
clicking a second time.

6. Click to mark the location on the screen you want to specify as
the trigger location. Drag the mouse to the opposite corner and
click again to finish the trigger placement. The trigger is now
set.
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Display: determines whether you will display the time, date,
or both.
Color:  allows you to select the color of the text as it will
appear on the PGI.

5. Click on Area and place the trigger name on the screen by
clicking a second time.

6. Click to mark the location on the screen you want to specify
as the trigger location, drag the mouse to the opposite corner
and click again to finish the trigger placement. The trigger is
now set.

Display Screen Trigger (DIS:)
The Display Screen trigger is used to display base screens. It is com-
prised of a touch screen area and destination base screen number. When
the user touches the area of the display trigger, the designated base
screen is displayed. When a zero is entered for the base screen number,
the Display trigger will display the previous screen.

Display Screen triggers can be protected. When a trigger is selected for
protection, a security code needs to be entered before the screen can be
displayed. When the trigger is pressed, a pre-programmed keypad is
displayed on the screen. The desired base screen will be shown only if
the correct code is entered.

If the user enters an incorrect code or if “cancel” is pressed, the screen
returns to the current view. The value of the code is not displayed, but a
“*” is returned for each key press. The security code is set and stored in
the system’s attributes. See System Attributes section in this manual.

How to create a Display Screen Trigger:

1. Click on Trigger under the Draw menu.

2. Click on Trigger Name and type in a new name for your
trigger, then click Edit.

3. Select Display Screen and click OK.
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4. You now need to make your selections in the following data
boxes:
Base Screen: determines which base screen the PGI will
switch to.
Protect Screen: allows you to control the changing of the
screens by requiring a password to be entered before the
change can be executed.
Confirm Write:  selects whether or not you want the trigger to
provide you with a confirmation request before it executes its
function.
Trigger Source: determines if this trigger is activated by an
area on the touch screen, an external keypad, or both. If you
select external keypad, you need to select which of the 16
function keys will be used to activate this trigger.

5. Click on Area and place the trigger name on the screen by
clicking a second time.

6. Click to mark the location on the screen you want to specify as
the trigger location, drag the mouse to the opposite corner and
click again to finish the trigger placement. The trigger is now
set.

Jump Trigger (JMP:)
The Jump trigger displays a symbol. The trigger can create an illusion
of animation by displaying the symbol in a different location every time
a registers value changes. You can change the location of the symbol up
to 30 places. The Jump trigger is typically used to show a part moving
along an assembly line from station to station.

How to create a Jump Trigger:

1. Click on Trigger under the Draw menu.

2. Click on Trigger Name and type in a new name for your
trigger, then click Edit.

3. Select Jump and click OK.

4. You now need to make your selections in the following data
boxes:
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Symbol Number: the number of the symbol that will be used
as the jump item.
Position Register: the register that the jump trigger will look
to for a value between 1 and 30.
Data Type: determines the data format the register will
represent.
Color 1: the foreground color of the symbol as it appears on
the PGI.
Color 2: the background color of the symbol as it appears on
the PGI.

5. Click one time to place the trigger name on the base screen.

6. Click on the area you want the symbol to appear. Then you
can continue to place the symbol in up to 30 different loca-
tions.  When you are done, simply press Enter to complete the
placement of the jump triggers. The triggers are now set.

Keypad Trigger (KYP:)
The Keypad trigger is used to write the keypad’s accumulator value to a
data register. This trigger consists of a touch screen area, a PGI register
address, and the data type (signed/unsigned decimal, hex, octal, BCD
or text). You must also specify whether the Trigger Source is a touch
screen or an external keypad. When the user touches the screen area,
the value in the keypad’s accumulator is written to the specified data
register.

If the register is BCD, the value is translated to BCD before being
written to the register. More than one KYP: trigger can be placed in the
same base screen to write values to multiple registers.

How to create a Keypad Trigger:

1. Click on Trigger under the Draw menu.

2. Click on Trigger Name and type in a new name for your
trigger, then click Edit.

3. Select Keypad and click OK.
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Library Screen Trigger (LIB:)
The Library Screen trigger displays the graphics or text of a library
screen when a PGI register bit is turned on or off. The trigger consists
of a library screen number, bit and register address, on or off state, and
the library screen’s location on the base screen. In addition, the library
screen and trigger address can be used more than once in the same or
other base screens. A typical use for the library screen is to show a
button that has been pressed. For example, an “off” button is placed on
a base screen, then an “on” button is programmed in a library screen.
This trigger is used to display the “on” button over the “off” button
when pressed.

When drawing a library screen it is important to draw as close to the
upper left hand of the screen as possible. When you include a library
screen the 0,0 point is used as the include point. This will allow you to
place the library screen anywhere on the base screen.

4. You now need to make your selections in the following data
boxes:
Destination Register: when you activate this trigger the
keypad accumulator will be transferred to this register.
Data type: the type of data that will be stored in the
destination register.
Operator Length:  determines whether the data should be
treated as a 16 bit (regular) or 32 bit (long) word.
Confirm Write:  selects whether or not you want the trigger to
provide you with a confirmation request before it executes its
function.
Trigger Source: determines if this trigger is activated by an
area on the touch screen, an external keypad, or both. If you
select external keypad, you need to select which of the 16
function keys will be used to activate this trigger.

5. Click one time to place the trigger name on the base screen.

6. Click to mark the location on the screen where you want the
trigger to be placed. Drag the mouse across the screen and
click again to finish the trigger placement. The trigger is now
set.

NOTE:
While drawing on the
screen, the mouse cursor
can be moved with the
cursor keys while holding
the control key down. This
can be used to allow ac-
curate positioning to be
done.
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How to create a Library Trigger:

1. Click on Trigger under the Draw menu.

2. Click on Trigger Name and type in a new name for your
trigger, then click Edit.

3. Select Library and click OK.

4. You now need to make your selections in the following data
boxes:
Library Screen: the number of the library screen that you
want to appear when the monitor bit becomes active.
Monitor Bit:  the bit that the PGI will monitor to determine
when the library screen should be displayed.
Active State: determines if the library screen should be
displayed on the ON or OFF state of the monitor bit.

5. Click on Area. Click one time to place the trigger name on the
base screen. At this time the library screen should appear and
be connected with the cursor for placement.

6. Click a second time to place the library screen on the base
screen at the location you want it to appear.

Message Trigger (MSG:)
The Message trigger is used to display message screens. Each trigger
consists of the following:

• Register to monitor — whenever the value of this register
changes, the new value is used as the message number. If the
value is not in the range of 1–999, the message “Invalid
message number” will be displayed. If the value is for a non-
programmed message screen, the message “Message XXX not
programmed” will be displayed.

• The text size to use when displaying the message.

• The color to use when displaying the message.
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• Four registers to be used for variable data set values. These
registers do not need to be contiguous. If a long variable data
set is used in a message, it will use the specified data set
register and the next contiguous register.

• The location of the displayed message on the base screen.

How to create a Message Trigger:

1. Click on Trigger Icon.

2. Type in a trigger name up to 32 characters.

3. Click on Edit.

4. Double Click on Message Screen (MSG:). The Message
trigger menu should now be displayed.

5. Click on Monitor Register and enter the PGI register you want
to monitor. The value in this register will be the message
number displayed.

6. Click on Register Format. This is where you set up how the
PGI interprets the data in the monitored register. Word is read
as unsigned decimal (binary) and Bit Format is read as each
bit displaying a message.

7. Click on Variable Data Register Field (1). Enter a PGI Regis-
ter number. The PGI reads the data in this register and displays
it within the message text. Please note that there are control
characters that need to be programmed in the Message Screen
to display the data. Regular or Long — if you select Regular
the data will be read from one register, if you select Long the
data will be treated as a true 32 bit word, where the entered
Monitor Register number holds the most significant digits and
the next contiguous register holds the least significant digits.

8. Click on Character Size. This sets the height and width you
want all messages to be.
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9. Click on Color and select the color for all the messages.

10. Click on Area. Now position the cursor where you want the
Trigger name placed. Note that the trigger name will only be
seen on the uWIN software and not on the PGI.

11. Click left button to position the name. Now position the cursor
to where you want the bottom part of the first character of the
Message to be displayed.

12. The trigger is now set.

Numeric Trigger (NUM:)
The Numeric trigger displays the value of a register. A typical use of
this trigger would be to display motor speeds, timer/counter values or
oven temperatures.

The user must enter the number of the Monitor Register, along with the
Total and Fractional Digits. The user must set height and width of the
Character Size and change the Data Type to signed or unsigned deci-
mal, hex, octal or BCD.

How to create a Numeric Trigger:

1. Click on the Trigger Icon.

2. Type in a trigger name up to 32 characters.

3. Click on Edit.

4. Double Click on Numeric (NUM:). The Numeric trigger menu
should now be displayed.

5. Click on Monitor Register and enter the PGI register you want
to monitor. The value in this register will be the number
displayed.

6. Click on Total Digits. Select how many digits you want
displayed. (e.g.: if your maximum value is 999 enter 3. If your
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PLS Trigger (PLS:)
The PLS trigger allows you to create a variable length bar displayed
along a linear graph.  The starting point and length of the bar are
dependent on two registers.

The on value register determines the starting point of the bar along the
line and the off value register determines the bar’s ending point.  The
minimum and maximum values allow for the scaling of data.  If the off
value is less than the on value, then the bar will be drawn as two parts,

maximum value is 99.9 enter 3 and in the Fractional Digits
field enter 1.)

7. Click on Character Size. This sets the height and width for the
value of the register.

8. Click on Data Type entry field. This selects the data base the
PGI uses to display the values.

9. Click on Operator Length. If you select Regular the data will
be written to the one register. If you select Long the data will
be treated as a true 32 bit word, where the Monitor Register
number holds the most significant digits and the next contigu-
ous register holds the least significant digits.

10. Click on Display Format. Set how you want the data to be
displayed.

11. Click on Color. Select the color for the value of the register.

12. Click on Area. Now position the cursor where you want the
Trigger name to be placed. Note that the trigger name will
only be seen on the uWIN software and not on the PGI.

13. Click the left mouse button to position the name.

14. Now position the cursor where you want the bottom part of
the first number of the value to be displayed. The trigger is
now set.
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one on each end of the line.  The bar is one pixel above or to the left of
the line.  The length of the ticks is the same as the width of the bar.
The area will be selected and edited with the mouse.

How to create a PLS Trigger:

1. Click on Trigger under the Draw menu.

2. Click on Trigger Name and type in a new name for your
trigger, then click Edit.

3. Select PLS and click OK.

4. You now need to make your selections in the following data
boxes:
Monitor On Register: the on value register determines the
starting point of the bar along the line.
Monitor Off Register:   the off value determines the bar’s
ending point
Minimum Value/Maximum Value:  values that allow for the
scaling of data..
Data Type: determines the form the data will take in the
monitored register.
Data Size:  determines the size the data will use in the moni-
tored register.
Direction: determines the direction for the linear graph.
Line Color:  allows you to select a color for the linear graph.
Number of Ticks: allows you to select the number of ticks.
Fill Pattern: allows you to select a fill pattern for the linear
graph.
Fill Foreground Color:  if you have a fill pattern selected, this
will be the foreground color.
Fill Background Color: if you have a fill pattern selected,
this will be the background color.

5. Click on Area to accept your choices and begin to place the
bar graph.

6. Click once to place the trigger name.
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Radio Button Trigger (RAD:)
The Radio Button trigger has a maximum of 16 buttons, however, only
one can be on at any given time. When a button is pressed, it releases
any button that may be on, and becomes the active button. Each button
is assigned a bit in an internal register and an area of the touch screen.

The pop-up window shows the write register and lists the defined bits.
The define button allows buttons to be placed individually.

How to create a Radio Trigger:

1. Click on the Trigger Icon.

2. Type in a trigger name up to 32 characters.

3. Click on Edit.

4. Double Click on Radio Button (RAD:). The Radio trigger
menu should now be displayed.

5. Click on Write Register entry field and enter the PGI register
number you want to write to.

6. Confirm Write is used as a “safety-net.” If it is selected, the
PGI will display a pop-up confirming selection of Yes or No to
activate the trigger.

7. Select the Trigger Source you want to activate the trigger.
Either the Touch-Cell, External Keypad, or both.  Note that if
you have selected Confirm Trigger and External Keypad only,
use the “C” and “E” on the External Keypad to select Yes or
No confirmation. The following steps are for setting up each
of the 16 bits in the register.

8. Click on 0 UNDEFINED and then click on Edit.

7. Click to mark the location on the screen where the linear
graph will be located. Drag the mouse to the opposite corner
and click again to finish the placement. The trigger is now set.
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Important:  You must place the cursor on a Touch-cell grid point and
draw the button big enough to cover at least one touch-cell. One
touch-cell is 40 pixels X 40 pixels.

9. Position the cursor on the desired location. (It is best to start
with the top/left corner and drag down/right.)

10. Click, do not hold, the left mouse button.

11. Drag the cursor down and right, then click to position the
second corner.

12. Now the Radio menu appears again. Repeat the above steps
for each bit you want to use. When you have defined your
required bits click on Exit and position the Trigger name in the
desired location.

Recipe Trigger (RCP:)
The Recipe trigger is similar to the Register Write trigger with the
exception that you will be able to enter up to 20 values. The values are
written to consecutive registers starting at the register specified by the
trigger. Only the number of values entered will be written.

How to create a Recipe Trigger:

1. Click on Trigger Icon.

2. Type in a trigger name up to 32 characters.

3. Click on Edit.

4. Double Click on Recipe (RCP:). The Recipe trigger dialog
box will now be displayed.

5. Click on Write Register entry field and enter the first PGI
register number you want to write a value to.

6. Click on Write Values. Enter the values you want written to the
PGI registers. The first field is the register number you entered
in the Write Register field. The second entry field is the value
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you want written to in the next contiguous PGI register on up
to 20 registers.

7. Click on Data Type entry field. This selects the data format
that the PGI will use to write the values.

8. Confirm Write is used as a “safety-net.” If it is selected, the
PGI will display a pop-up confirming selection of Yes or No to
activate the trigger.

9. Select the Trigger Source you want to activate the trigger.
Either the Touch-Cell, External Keypad, or both. Note that if
you have selected Confirm Trigger and External Keypad only,
use the “C” and “E” on the External Keypad to select Yes or
No confirmation.

10. Click on Area. Now position the cursor where you want the
Trigger name to be placed. Note that the trigger name will
only be seen on the uWIN software and not on the PGI.

Important:  You must place the cursor on a touch-cell grid point and
draw the button big enough to cover at least one touch-cell. One
touch-cell is 40 pixels X 40 pixels.

11. Click the left mouse button to position the name. Now posi-
tion the cursor on the desired location. (It is best to start with
the top/left corner and drag down/right.)

12. Click, but do not hold, the left mouse button.

13. Drag the cursor down and right, then click to position the
second corner. The trigger is now set.
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Register Write Trigger (REG:)
The Register Write trigger is used to write a constant to a PGI (internal)
register. The user must enter a Write Register and Write Value. The
Data Type allows the user to select one of the following options: signed
or unsigned decimal, hex, octal or BCD.

The Register Write trigger also includes functions such as Confirm
Write that must be set to yes or no, and Trigger Source that can be
either a touchscreen or an external keypad.

How to create a Register Write Trigger:

1. Click on Trigger Icon.

2. Type in a trigger name up to 32 characters.

3. Click on Edit.

4. Double Click on Register Write (REG:). The Register Write
trigger menu should now be displayed.

5. Click on Write Register entry field and enter the first PGI
register number you want to write a value to.

6. Click on Write Value. Enter the value you want to write to the
register.

7. Click on Data Type field. This selects the data base format the
PGI will use to write the values.

8. Click on Confirm Write. This is used as a “safety net.” If
selected, the PGI will display a pop-up confirming the selec-
tion of Yes or No to go ahead and activate the trigger. Select
the Trigger Source you want to activate the trigger. Either the
Touch-Cell, External Keypad, or both. Note that if you have
selected Confirm Trigger and External Keypad only, use the
“C” and “E” on the External Keypad to select Yes or No
confirmation.

9. Click on Area. Now position the cursor where you want the
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Report Screen Trigger (RPT:)
The Report Screen trigger allows you to display or print the report
screen. When a report screen is displayed two buttons will appear at the
bottom of the screen. One is to print the screen and the other will return
to the base screen. A report screen will only contain alphanumeric
information, not graphics. Note that the print button is displayed even
if the trigger causes the report to be printed.

How to create a Report Screen Trigger:

1. Click on Trigger Icon.

2. Type in a trigger name up to 32 characters.

3. Click on Edit.

4. Double Click on Report Screen (RPT:). The Report Screen
trigger menu should now be displayed.

5. Click on Report Screen entry field and type in the Report
Screen number you want to control when the button is

Trigger name to be placed. (The trigger name will only be seen
on the uWIN software and not on the PGI.)

10. Click the left mouse button to position the name.

Important:  You must place the cursor on a touch-cell grid point and
draw the button big enough to cover at least one touch-cell.  One
touch-cell is 40 pixels X 40 pixels.

11. Now position the cursor on the desired location. (It is best to
start with the top/left corner and drag down/right)

12. Click, but do not hold, the left mouse button.

13. Drag the cursor down and right, then click to position the
second corner. The trigger is now set.
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pressed. If Display Report When Triggered is set to YES, the
Report Screen number in the Report Screen entry field will be
displayed when the button is pressed. If Print Report When
Triggered is selected, the text of the Report Screen number in
the Report Screen entry field will be printed out the Aux port
of the PGI when the button is pressed.

Confirm Trigger is used as a “safety-net.” If it is selected, the
PGI will display a pop-up confirming the selection of Yes or
No to go ahead and activate the trigger. If Send to Slave is
selected the text of the Report Screen number in the Report
Screen entry field will be sent out to UTICOR Message
Displays from the Com2 port of the PGI when the button is
pressed.  Group & Unit refers to the addressing scheme of
UTICOR Slave Displays. Select the Trigger Source you want
to activate the trigger. Either the Touch-Cell, External Keypad,
or both.  Note that if you have selected Confirm Trigger and
External Keypad only, use the “C” and “E” on the External
Keypad to select Yes or No confirmation.

6. Click on Area. Now position the cursor where you want the
Trigger name to be placed. Please note that the trigger name
will only be seen on the uWIN software and not on the PGI.

7. Click the left mouse button to position the name.

Important: You must place the cursor on a Touch-cell grid point and
draw the button big enough to cover at least one touch-cell. One
touch-cell is 40 pixels X 40 pixels.

8. Now position the cursor on the desired location. (It’s best to
start with the top/left corner and drag down/right)

9. Click, do not hold, the left mouse button.

10. Drag the cursor down and right, then click to position the
second corner.  The trigger is now set.
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Scaled Keypad Trigger (SKP:)
The Scaled Keypad trigger allows data from a keypad accumulator to
be scaled before being stored to a register. It is the same as the Keypad
trigger with the exception that it contains four additional fields: mini-
mum and maximum register values, and minimum and maximum entry
values. Keypad data between the minimum and maximum entry values
is scaled and shifted to the same relative position between the register
minimum and maximum values before being stored in the specific
register.

How to create a Scaled Keypad Trigger Button:

1. Click on Trigger Icon.

2. Type in a trigger name up to 32 characters.

3. Click on Edit.

4. Double Click on Scaled Keypad (SKP:). The Scaled Keypad
trigger menu should now be displayed.

5. Click on Destination Register and enter the number of the PGI
register you want to receive the keypad data.

6. Click on Entry Values Minimum. This is the low end set point.
The operator will not be allowed to enter a value lower than
the value in this field.

7. Click on Entry Values Maximum. This is the high end set
point. The operator will not be allowed to enter a value higher
than the value in this field.

8. Click on Register Values Minimum. This is the actual low end
value that will be put into the Destination Register.

9. Click on Register Values Maximum. This is the actual high end
value that will be put into the Destination Register.

10. Click on Data Type entry field. This selects what data base the
PGI will use to write the values.
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11. Click on Operator Length. If you select Regular the data will
be written to one register. If you select Long, the data will be
treated as a true 32-bit word, where the Write Register number
holds the most significant digits and the next contiguous
register the least significant digits. Confirm Write is used as a
“safety net.” If it is selected, the PGI will display a pop-up
confirming the selection of Yes or No to activate the trigger.
Select the Trigger Source you want to activate the trigger and
either the Touch-Cell, External Keypad, or both. Note that if
you have selected Confirm Trigger and External Keypad only,
use the “C” and “E” on the External Keypad to select Yes or
No confirmation.

12. Click on Area. Now position the cursor where you want the
Trigger name to be placed. The trigger name will only be seen
on the uWIN software and not on the PGI.

Important:  You must place the cursor on a Touch-cell grid point and
draw the button big enough to cover at least one touch-cell. One
touch-cell is 40 pixels X 40 pixels.

13. Click the left button to position the name. Position the cursor
on the desired location. (It is best to start with the top/left
corner and drag down/right)

14. Click, do not hold, the left mouse button.

15. Drag the cursor down and right, then click to position the
second corner. The trigger is now set.

Scaled Numeric Trigger (SNU:)
This trigger allows data to be scaled before being displayed. It is the
same as the numeric trigger function, with the exception that it contains
four addition fields: minimum/maximum register values and minimum/
maximum display values. A typical use is to show 0 to 100 percent of
flow control from a 4-20 mA input signal.

How to created a Scaled Numeric Trigger:

1. Click on the Trigger Icon.
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2. Type in a trigger name up to 32 characters.

3. Click on Edit.

4. Double Click on Scaled Numeric (SNU:). The Scaled Numeric
trigger menu should now be displayed.

5. Click on Monitor Register and enter the PGI register you want
to monitor. The value(s) in this register will be the number(s)
that gets displayed.

6. Click on Total Digits. Select how many digits you want dis-
played (e.g.: if your maximum value is 999 enter 3. If your
maximum value is 99.9 enter 3 and in the Fractional Digits
field enter 1.)

7. Click on Display Values Minimum. This is the low end set
point the PGI will display to the operator.

8. Click on Display Values Maximum. This is the high end set
point the PGI will display to the operator.

9. Click on Register Values Minimum. This is the actual low end
value that is in the Monitor Register.

10. Click on Register Values Maximum. This is the actual high end
value that is in the Monitor Register.

11. Click on Character Size. This sets the height and width you
want the value of the register to be.

12. Click on Data Type entry field. This selects the data format
that the PGI uses to display the values.

13. Click on Operator Length. If you select Regular the data will
be written to the one register. If you select Long, the data will
be treated as a true 32-bit word, where the Monitor Register
number holds the most significant digits and the next contigu-
ous register holds the least significant digits.
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14. Click on Display Format. This is where you set how you want
the data to be displayed.

15. Click on Color and select the color for the value of the
register.

16. Click on Area. Now position the cursor where you want the
Trigger name to be placed. Note that the trigger name will
only be seen on the uWIN software and not on the PGI.

17. Click the left mouse button to position the name.

18. Now position the cursor to where you want the bottom part of
the first number of the value to be displayed.

19. The trigger is now set.

Symbol Trigger (SYM:)
The Symbol trigger is used to display a symbol created in the symbol
screen. The trigger displays the symbol when the specified discrete
element is turned on or off. This is typically used when you want to
show the status of a pump, whether it is on or off, or if a valve is open
or closed.

How to create a Symbol Screen Trigger:

1. Click on the Trigger Icon.

2. Type in a trigger name up to 32 characters.

3. Click on Edit.

4. Double Click on Symbol (SYM:). The Symbol Screen trigger
menu should now be displayed.

5. Type in the Symbol screen you want to display when a bit in a
register is on.

6. Click on Monitor Bit field and enter the PGI register number
and bit you want to monitor (e.g.: 2/7 where 2 is the PGI
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Text String Trigger (TXT:)
This trigger displays the contents of a group of registers as an ASCII
text string. The Text String trigger consists of a discrete bit address, an
on/off state, the starting register address, total number of registers,
video attributes, character size and base screen locations. The Text
String trigger is typically used for displaying part numbers, VIN num-
bers or production numbers.

How to create a Text String Trigger:

1. Click on the Trigger Icon.

2. Type in a trigger name up to 32 characters.

3. Click on Edit.

register, “/” is the register bit separator, and 7 is the bit to
monitor in register 2.)

7. On Attributes Color 1 is the color that you want the “on”
pixels of the Symbol screen to be when the bit is on. On
Attributes Color 2 is the color that you want the “off” pixels of
the Symbol screen to be when the bit is on. Off Attributes
Color 1 is the color that you want the “on” pixels of the Sym-
bol screen to be when the bit is off. Off Attributes Color 2 is
the color that you want the “off” pixels of the Symbol screen
to be when the bit is off.

8. Click on Area. Now position the cursor where you want the
Trigger name to be placed. Note that the trigger name will only
be seen on the uWIN software and not on the PGI.

9. Click the left button to position the name. Now position the
cursor where you want the center of the Symbol to be dis-
played.

10. Click the left button to position.

11. The trigger is now set.
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4. Double Click on Text String (TXT:). The Text String trigger
menu should now be displayed.

5. Click on the Monitor Bit entry field. This register bit is used
by the PGI to indicate when to display in ASCII the values in a
block of registers.

6. Enter the register and bit (e.g.: 2/7 where 2 is the PGI register,
“/” is the register bit separator, and 7 is the bit to monitor in
register 2.)

7. Click on Starting String Register entry field and enter the first
PGI register number in the block of registers you want the PGI
to read the values of and display in ASCII.

8. Click on Number of Registers. Here is where you define the
total number of registers in the block. Each register can handle
2 characters. The maximum number of registers in the block is
20. The text string will be terminated as soon as the byte is
found to have the value of 0, so each register should contain
two characters.  If the string has an odd number of characters,
the last letter should be in the upper byte of the register (e.g.,
4100 in hex will end the string in a capital A.)

9. Click on Character Size. Set the height and width of the text.

10. The Display State tells the PGI to display the text when the bit
is on or when it is off.

11. Click on Color and select the color you want the text to be.

12. Click on Area. Now position the cursor where you want the
Trigger name to be placed. Note that the trigger name will
only be seen on the uWIN software and not on the PGI.

13. Click the left button to position the name.

14. Now position the cursor where you want the bottom part of
the first character to be displayed.

15. The trigger is now set.
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The Include Function
The Include function is a very important part of creating an operator
interface with the PGI. It allows objects drawn on library, symbol,
linegraph and keypad screens to be “linked” with base screens. Objects
placed on programming screens are linked to their origin. When a
change is made to the original drawing, it is also reflected on all the
subsequent destination screens. For example, if you do a screen invert
of a symbol, the change will occur on all of the screens where the
symbol is displayed. This is true of all screens with included objects.

Include Library
This feature links the selected library screen with the displayed screen.
Any object drawn on the library screen will be displayed in the destina-
tion screen of the include. An object drawn on a library screen can be
imported or linked to a base, library, keypad or linegraph screen. When
you select the Include function, a pop-up window is displayed and
prompts you to select the number and name of the screen. Make the
selection and any images on the screen will appear on the destination
screen. The entire library screen is incorporated onto the destination
screen with the upper left coordinates of the library matching the
include point.

Include Symbol
The include symbol command is similar to the include library screen in
that it allows you to place a previously drawn symbol onto the current
screen. The symbol screen can be included in a base, library, linegraph
and keypad screen.

Include LineGraph
The include linegraph allows you to link a linegraph with a base
screen.

Include Keypad
This command allows you to incorporate the contents of this screen
into a destination screen. In addition to any drawn object, keypad
triggers are also transferred. It can be included into a base screen only.

NOTE:
Remember that when in-
cluding a screen, all im-
ported objects will be
placed on top of any ex-
isting objects already on
the base screen.

NOTE:
In order to move, copy or
delete a library, symbol,
keypad or linegraph after
you have included it onto
a base screen, you have
to select the include point.
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Import DXF
This allows you to import disk files with a DXF extension. The com-
mands that are supported are: line, polyline (including rectangles),
circles, arc, text, trace, solid and block. DXF colors are translated to the
following PGI colors:

DXF file color code PGI color code

Red (1) Red (5)
Yellow (2) Yellow (7)
Green (3) Green (3)
Cyan(4) Cyan(4)
Blue (5) Blue (2)
Magenta (6) Magenta (6)
Black (7) or Gray (8) White (8)

AutoCad® has a “drawing field” that can be sized.  This should be set to
the following PGI display size: EL display 7.7 x 4.8; TFT color display
8.315 x 6.236. You can set the AutoCad® drawing field to inches to
match the PGI dimensions. In addition, a one-to-one ratio can be
achieved. You can also set up AutoCad® to display in pixels.

Drawing Tools

These Drawing Tools are located at the top of the Main Programming
Screen. Any of the above draw functions can be accessed by choosing
the appropriate selection on the Draw menu or by clicking on the
specified Draw icon.

Line
The Line draw tool allows you to draw line segments.

To draw a line:
1. Click on the Line icon or select Line from the Draw menu.

2. Select a point on the screen with the pointer and click the left
mouse button. Move the mouse to draw the line. When you’ve
completed the line, click the button again to terminate the
segment.

NOTE:
When creating a .DXF file
to import, it is important
that you select initial de-
faults and thereby select
everything in the drawing
and the system variables
to be stored to file.
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Selecting Line Attributes

To select the line color:
1. Click on the color indicator at the bottom left of the screen. A

menu indicating available screen colors will be displayed.

2. Click on the desired color.

To select the line type:
1. Click on the line indicator at the bottom of the screen. A menu

indicating available line types will be displayed.

2. Click on the desired line type.

PolyLine
The Polyline draw tool allows you to draw a series of connected lines.
It has the same characteristics as the line draw tool, with the exception
that to terminate the polyline you must click the right mouse button.

To draw a polyline:
1. Click on the Polyline icon or select Polyline from the Draw

menu.

2. Select a point using the left mouse button and continue to
select points along the polyline by clicking the left mouse
button.

Rectangle
The Rectangle draw tool allows you to draw a complete rectangle.

To draw a rectangle:
1. Click on the Rectangle icon or select Rectangle from the Draw

menu.

2. Select a point on the screen with the pointer and click the left
mouse button to locate the first corner of the rectangle. Pull
the box with the mouse to the size you want and click the left
mouse button to set the box size.
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Filled Rectangle
This tool allows you to draw a rectangle filled with a pattern or color.

To draw a Filled rectangle:
1. Click on the Filled Rectangle icon or select Rectangle > Filled

from the Draw menu.

2. Select a point on the screen with the pointer and click the left
mouse button to locate the first corner of the rectangle. Pull
the box with the mouse to the size you want and click the left
mouse button to set the box size.

Selecting Fill Attributes

To select the fill pattern:
1. Click on the pattern indicator at the bottom of the screen.  A

menu indicating the available patterns will be displayed.

2. Click on the desired pattern.

To select the fill color:

1. Click on the left color indicator at the bottom of the screen to
indicate the foreground color — the color indicator on the
right shows the background color.  A menu indicating the
available colors will be displayed.

2. Click on the desired color.

Circle
The Circle draw tool allows you to draw a circle.

To draw a circle:
1. Click on the Circle icon or select Circle from the Draw

menu.

2. Select a point on the screen with the pointer and click the left
mouse button to locate the starting point of the circle. Pull the
circle with the mouse to the size you want and click the left
mouse button to set the perimeter size.
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Filled Circle
The Filled Circle draw tool allows you to draw a filled circle.

To draw a Filled circle:
1. Click on the Filled Circle icon or select Circle > Filled from

the Draw menu.

2. Select a point on the screen with the pointer and click the left
mouse button to locate the starting point of the circle. Pull the
circle with the mouse to the size you want and click the left
mouse button to set the perimeter size.

Arc
The Arc draw tool allows you to draw an arc.

To draw an arc:
1. Click on the Arc icon or select Arc from the Draw menu.

2. Select a point where the arc will begin. The next point repre-
sents the end point, and this describes the size of the base.
After the second point has been set, move the cursor until the
arc has the desired shape and click the left mouse button.

Pie
The Pie draw tool allows you to draw a pie shape.

To draw a pie:
1. Click on the Pie icon or select Pie from the Draw menu.

2. Select the first point where the pie will begin. The next point
represents the point where the cutout will terminate. After the
second point has been set, move the cursor until the pie has
the desired shape and click the left mouse button.

Filled Pie
The Filled Pie tool allows you to draw a pie shape with a fill pattern or
color.
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To draw a Filled pie:
1. Click on the Draw menu and select Pie > Filled.

2. Select the first point where the pie will begin. The next point
represents the point where the cutout will terminate. After the
second point has been set, move the arrow around to view the
outline of the pie shape.

Fill
The Fill draw tool allows you to fill a closed object with a pattern or
color.

To fill an object:
1. Click on the Fill object icon or select Fill from the Draw

menu.

2. Select the fill type and fill color as you would for defining the
other filled object commands such as the filled pie or filled
rectangle. Click on a point within the enclosed object to start
the fill.

Text
The Text option allows you to enter text on the screen.

To enter text:
1. Click on the Text icon or select Text from the Draw menu.

2. Click the left mouse button again, begin entering your text.

3. Move the mouse around to position the text. Once it is where
you want it, click the left mouse button again to place it. Text
size and direction can be selected in the Options > Preferences
> Display menu.

Multiline Text
The Multiline Text option allows you to enter multiline text on the
screen.

NOTE:
Before placing text turn
off the snap feature un-
der the Option pulldown
menu.  This allows free
movement of the text
when trying to place it.
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To enter multiline text:
1. Click on the Multiline Text icon or select Multiline Text from

the Draw menu.

2. Draw a rectangle with the mouse on the screen where the
multiline text is to be displayed.

3. The Edit Multiline Text pop-up window will be displayed.
Enter the text message. If you want to change the text at-
tributes, click on the attributes button.
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EDIT MENU

Editing

The PGI is equipped with advanced editing tools. These encompass a
wide selection of functions that range from global screen redraw to
undoing the previous command. Editing commands fall under the Edit
pulldown menu and are also accessible by using the Editing Toolbar
icons on the Main Programming Screen. This toolbar is found in the
top left of the Main Programming Screen. Selecting any of these tools
will access the specified function.

Select Object Function
The Select toolbar button allows the user to pick the selection mode.
The mouse cursor is shown as an arrow while in the selection mode
and as a cross-hair if a drawing tool has been chosen. An object must
be selected before the Cut, Copy, Delete, Move, Scale, Rotate and Edit
Item functions will work.

Single object selection is accomplished by clicking the left mouse
button while the cursor is positioned on the object. If multiple objects
reside under the selection point only the top one will be selected. An
object can be de-selected by clicking on another object or by clicking
in an area with no objects.

Multiple objects can be selected by holding down the control key
while selecting or manipulating the group of objects. They can also be
selected by dragging a rectangle around all of the objects while hold-
ing the left mouse button down.

Selected objects have stretch points drawn on their extremities. The
user can grab a stretch point and enlarge the object by dragging it with
the left mouse button held down. To move an object without stretching
it, select a point on the object other than one of the stretch points, and
drag the object while holding the left mouse button down.

If multiple objects are selected, stretch points will be drawn on each
object to indicate the objects are selected, but the stretch points will
not function. Dragging any of the selected objects will cause them all

NOTE:
To select an �included�
object, you must click on
the �Include Point.� To
display the include point
it must be selected from
the Options menu. Select
Preferences and then
choose Display to acti-
vate this function. The
same rule applies to fill
points.
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to move. If multiple objects are selected, a bounding rectangle with
dotted lines appears, enclosing all of the selected objects. This rect-
angle has stretch points that are functional. All objects within the
enclosed area will be stretched and positioned to maintain their relative
positions within the rectangle.

Text objects or text within any object cannot be stretched. This is
because the fonts are in discrete sizes. If an object or group of objects
containing text are stretched, the text will attempt to maintain its
relative position within the object(s), but the text itself will not change.
Also, circles cannot be made into ellipses (the PGI does not support
ellipses), they can only be made bigger or smaller.

To select a trigger click on one of its insertion points. Triggers that
have defined areas can be selected by clicking on the edge of this area.
Triggers with multiple areas, such as Radio or Jump triggers, are all
redrawn with selection points if any of their areas are selected. An area
can be individually stretched, but the only way to stretch the trigger as
a whole is to select it in a group with other objects.

Undo
The undo option is used to reverse the previous command. This func-
tion must be performed next in order for the command to be undone.
The undo command is one level deep.

Cut
This allows you to cut (remove) a selected item or items to the win-
dows clipboard.

To copy an object to the clipboard:
1. With your mouse select the object(s) to be cut.

2. Click on the Cut icon from the toolbar or use the Edit menu.

Copy
This allows you to copy (without removing) a selected item or items to
the Windows clipboard.

To copy an object to the clipboard:
1. With your mouse select the object(s) to be copied.
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Paste
This allows you to paste a selected item onto the displayed screen from
the Windows clipboard.

To paste an object from the clipboard:
1. Click on the paste icon from the toolbar or select paste from

the Edit menu.

2. Using the mouse, drag the pasted object(s) from the upper left
corner of the screen to the desired location.

Edit Item
This command allows you to edit an object’s characteristics.

To edit an item:
1. Using the mouse select the item to be edited.

2. Click on the Edit Item icon or select Edit Item from the Edit
menu.

3. The Edit Item function is specific to the type of item you
choose to edit. For example, if you select text to edit, the Edit
Text pop-up window will appear and allow you to change the
parameters for the selected text.

Scale
This allows you to increase or decrease the size of an item by a speci-
fied factor. Text cannot be scaled.

To scale an item:
1. Using the mouse, select the item(s) to be scaled.

2. Select the Scale function from the Edit menu.

3. When the scale pop-up window appears, click on the box next
to the Scale Factor and enter a number for the scale  factor.
Click OK.

2. Click on the Copy icon from the toolbar or use the Edit menu.

NOTE:
You can paste text from
other Windows applica-
tions by cutting or copy-
ing the text and pasting
(Ctrl + Insert) into: Multi-
line Text Field, Alarm Text
Field, and Message Text
Field.
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Move
This command allows you to move an item and/or trigger (within the
same screen) from one location to another.

To move an object:
1. Click on the Select Items icon from the toolbar.

2. If you are moving a drawn object or a ToolBox object, click
the pointer tool anywhere on the line of the item. If you are
moving a circle, click directly on the circumference of the
circle. If you are moving a trigger, click directly on the inser-
tion point of the trigger. The insertion point is marked with an
X in the top left hand corner.

3. Continue to hold the left mouse button down and move the
object to the selected location on the screen. Release the left
mouse button to place the object.

4. To move a group of objects, a boundary line must be drawn
around all the items you wish to move. Position the pointer
tool at the top left hand corner, click the left mouse button,
and drag the mouse down and right to include all of the ob-
jects you wish to move. Release the left mouse button.

5. Hold down the control key and click one of the selected items.
Continue holding the left mouse button down and move the
items to the selected area of the screen, release the mouse
button to place the objects.

Rotate
This command allows you to rotate an item on the screen. Text cannot
be rotated.

To rotate an item:
1. Use the mouse to select the item(s).

2. Click on the Rotate function from the Edit menu.

3. When the rotate pop-up window appears, click on the box next
to the Rotate Angle and select 90°, 180°, or 270° to rotate the
item. Click on OK.
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Delete
This removes a selected item without placing it on the clipboard.

To delete an item:
1. Using your mouse select an item(s) to delete.

2. Select Delete from the Edit menu.

SCREEN MENU

Base Screens
Base screens are used to help build project screens that will be dis-
played on the PGI 100. The base screen can be chosen from the PGI
touch screen or controlled by a PLC or computer. Other screen types
can be included and displayed on the base screens. The range of base
screen numbers is 1–999.

Base screens are primarily used to incorporate triggers and ToolBox
objects. Placing these items onto a base screen allows the user to have
input and control over what is being displayed on the PGI.  Triggers
and ToolBox objects can only be used in base screens, with the excep-
tion of a few triggers that can be used in report screens as well.

When a base screen is selected, the Base menu is added to the Main
Programming Screen. This enables you to change the background color
of the base screen being viewed.

The F9 key will cause the entire screen to be displayed without any
frame or menus. This will allow the whole PGI 100 screen to be
viewed on computers with only 640 X 480 resolution, which includes
most laptop computers.

Library Screens
Library screens are where basic program building blocks are drawn.
They can represent buttons, switches, activators and more. Once the
drawn object is saved it can be included onto a base screen. For ex-
ample, you can draw a generic button and include it onto a base screen
where it can be copied to produce a whole screen of identical buttons.
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Symbol Screens

The symbol screen is used to draw bitmapped images. They can repre-
sent motors, pumps, valves — almost anything you need to show.
Symbol dimensions can be a maximum of 96 X 96. (Remember that
the the PGI is limited to 96 x 96 pixels and two colors, on and off.)
Column size must be divisible by eight and row size by two.

The icons on the tool bar are from left: invert screen, clear symbol, and
symbol dimensions.

Invert Screen Clicking on this and the screen inverts the
foreground and background colors.

Clear Symbol Clicking on this icon clears the pixels.

Symbol
Dimensions

Clicking on this icon displays a pop-up
window that allows you to edit the dimensions
 the symbol.

How to create a Symbol Screen:
1. From the Screen menu, click on Select and choose Symbol.

2. Enter a new screen number and title, click on Select.

3. Symbols are drawn on a pixel by pixel basis and can be
dimensional from a size of 8 columns by 2 rows up to 96
columns by 96 rows. Column dimensions must be divisible by
8 and row dimensions divisible by 2. Adjustments can be
made by choosing Dimensions from the Symbol menu.
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4. Once you have selected the size of the symbol, a grid will
appear on the left side of the screen allowing you to create the
symbol.

5. To create a symbol, hold down the left mouse button in the
grid.  As you move the mouse across the screen each pixel
becomes highlighted. If you need to clear a highlighted pixel,
place your cursor on that particular pixel and click the right
mouse button. Note that while you are drawing the symbol, it
will always appear white.  Once you include it onto a base
screen it will appear as the color you have selected.

6. While you are creating your symbol it appears at its actual size
to the right of the screen.

7. When you are done creating the symbol, click on Save Screen
to save it to your file.

8. Located under the Symbol Menu are selections to import and
export bitmapped images. To import an image, choose Import
Bitmap, then select the drive and directory where the file is
located. Select the correct file name and click OK. To export a
bitmap provide the symbol with a filename and select the
“export to” directory. Click OK.

LineGraph Screens
Linegraph screens are a special type of library screen. These screens
are where all the parameters for developing a linegraph are set. They
continously monitor specific registers in the PGI 100. Up to 255 regis-
ters can be monitored per line graph and up to 999 linegraphs can be
programmed.

Linegraphs are unique in that most of the work is done for you. The
linegraph plots register values on a line as they change over a period of
time or by bit transition. The minimum number of readings in a
linegraph is two.

An important feature of the PGI is that it updates graph information all
the time. Linegraph screens can also contain graphics, text, libraries
and symbols. You assign a unique number when the screen is created.
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⇐ LineGraph Draw Axis
The chart is set up with the vertical axis
(Y) representing the register value and the
horizontal axis (X) represents time.

LineGraph Parameters ⇒
The parameters control the minimum and
maximum values of the linegraph along
with the number of readings and at what
interval.

How to create a LineGraph Screen:
1. Under the Screen menu, click on Select and choose Linegraph.

2. Enter a new number and click on Select.

3. At this time you are asked to enter the Linegraph parameters.
Use the tab key to move from one parameter to another.
Minimum Value:  the smallest number your linegraph will
show — this will be the X axis.
Maximum Value:  the largest number the linegraph will show
— this will be the absolute top of the graph.
Number of Readings: the number of readings you will see on
the linegraph at one time. The maximum number of readings
is 64.
Reading Interval: can be timed or triggered by an event.
Timed — how often, in seconds, the linegraph will update
between 1 and 65535 seconds.
Triggered — this is triggered by a monitor bit in the PGI
registers that will be monitored to update the linegraph. The
trigger state conveys whether the linegraph will be updated
when the monitor bit is on or off.

4. Click OK to select the parameters.

5. Now you must draw the size of the linegraph. Position the
cursor at the starting point of the linegraph. Click the left
mouse button and drag the mouse from one corner of the
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screen to the opposite corner. Click the left mouse button a
second time to complete the placement of the linegraph.

6. To change the color or the amount of tick marks on the
linegraph click on Draw Axis from the Linegraph menu. Here
you have the option of viewing and changing the color of each
axis individually.

Under the X Axis you have the following options:
Readings per tick — how many readings you want the PGI to
take before it moves to the next horizontal position on the
linegraph. Tick line length — how many pixels long you want
the tick marks to be.

Under the Y Axis you have the following options:
Units per tick — how many units each tick mark will repre-
sent. For example, if units per tick is set to 10 and the full
range of your linegraph is 0–100, you would have 10 ticks on
the Y Axis. Tick line length — how many pixels long you
want the tick marks to be.

7. At this point you need to select the registers you will moni-
tor. The registers you choose will be shown on the linegraph.

8. Click on Element from the Linegraph menu.

9. Enter a PGI address in the Element Box. This must be a full
register location.

10. Click on Edit. This screen provides you with the options to
change the line type and color along with what type of data is
read from the monitored register.

11. Click OK.

12. You can now enter another element to be monitored on this
same linegraph. There can be up to 20 elements per linegraph.
After you are done entering your elements click on Exit.
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13. Other options under the Linegraph menu include:
Parameters: This allows you to change the parameters you
originally set up when you created the linegraph.
Area Edit:  This allows you to move the location of the
linegraph on the screen as well as change the size of the
linegraph.
Show Area: This will show the complete area that the
linegraph will cover on the screen. This option is toggled on
and off.

14. Click on the Save Screen icon to finish creating your
linegraph.

Keypad Screens
Keypad screens are used to facilitate the entry of numbers by operators.
They are drawn using graphical elements and special keypad triggers.
Keypad screens must be included into a base screen to be used. Similar
to library screens, they can be included into several different base
screens. However, you are limited to one keypad per base screen. The
keypad screen range is 1–999.

Keypad Triggers
The K: triggers consist of a touchscreen
area. When the area is pressed the
trigger is activated. Triggers K:0
through K:F cause the digit to be
shifted into the accumulator. K:sign
changes the sign of the accumulator
and K:clear sets the accumulator to
zero. K:A through K:Z allow text entry
of the K:trigger. The keypads accumu-
lator is also cleared when a keypad
trigger is pressed or by switching
screens.

KEYPAD ACCUMULATOR

There is only one keypad
accumulator and it is
used by all keypads. The
accumulator can be a 16-
bit register with a range
o f :
Signed Decimal: -32768 to
+ 3 2 7 6 7
Unsigned Decimal: 0 to
6 5 5 3 5
Octal: 0 to 177777
Hex: 0 to FFFF
BCD: 0 to 9999

— or it can be a 32 bit
register with a range of:

Signed Decimal:
 -2,147,483,648 to
+ 2 , 1 4 7 , 4 8 3 , 6 4 7
Unsigned Decimal: 0 to
4,294,967,295
Octal: 0 to
37,777,777,777
Hex: 0 to FFFFFFFF
BCD: 0 to 99,999,999
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Selecting Edit on the Keypad Trigger
dialog box displays the screen to the
right, Accumulator Parameters. This
screen allows you to define the num-
ber of digits, color, character size and
display format of the keypad’s accu-
mulator.

Keypad Type
This function can be accessed
when you are in a Keypad screen
and the Keypad menu is available.
It allows you to change Data
Types, Operator Length and the
type of Trigger Source.

How to create a Keypad Screen:

1. From the Screen menu, click on Select and choose Keypad.

2. Enter a new keypad screen number and title, click on Select.

3. With the grid set to 40 X 40, start drawing a rectangle one
touch pad in size, one grid down and all the way to the left.

4. Continue drawing rectangles until you have a 3 wide by 4 high
grid. This will be the main body of your keypad.

5. Draw one last rectangle at the top that is 3 wide by 1 high.
This is where you will place the accumulator.

6. Next, label the rectangles so that they resemble a calculator.
Use the Text toolbar button to enter this information. Along
with the numeric entries, you should designate a Clear and
Enter button. This will use up the 12 rectangles on the screen.
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7. In order to assign each rectangle the value that it will repre-
sent, you must use the Keypad Triggers under the Keypad
menu. Under the Keypad menu click on Keypad Triggers.

8. A window containing each keypad trigger will appear. You
must state whether the trigger is undefined or state the loca-
tion of the trigger.

9. Click on K:0 and then select Edit. The software is now asking
you to box in the rectangle that represents the 0 on the keypad.
To do this, click on one corner of the rectangle and drag the
cursor to the opposite corner of the rectangle, then click the
mouse button again. Continue repeating these steps until all of
the triggers on the keypad are defined.

10. To define the accumulator, click on the accumulator trigger
and select Edit. A window will appear allowing you to select
the color, number of digits, character size and display format
for the accumulator. After you have defined these options
click OK. The accumulator is now attached to your cursor.
Place the accumulator in the box at the top of the keypad and
click your mouse to finish the placement.

11. Click on Exit and save the screen.

Alarm Screens
Alarms display Alpha-Numeric Text when either a discrete bit or a
value is outside of a preset range. The alarm can be displayed as long
as the bit remains active. When multiple alarms are set they are dis-
played one after another in the order they were triggered and will state
the alarm number and total alarms in the queue. The PGI 100 will
monitor a maximum of 100 alarm inputs.

An alarm consists of a 34-character text message. When an alarm is
triggered, it is displayed across the bottom of the screen in a 2 X 2 text
size.

To select or create an alarm, click onto the Screen menu and choose
Select > Alarms.
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Alarm Type
This is where the alarm type is viewed, it can be either discrete or
register. To select the alarm type, click on the discrete or register
button at the top of the screen.

Monitor Address
Enter the PGI address that is to be monitored by the alarm. This is
entered in register or discrete form depending on the alarm type selec-
tion.

Discrete State
If the alarm is discrete type, click the On or Off button at the top of the
screen to enter the state of the discrete element that should activate the
alarm. This states whether the element is active ON or OFF.

Register Set Point
Sets the low and high limits of the monitored register. As long as the
value in the register is within and including the low and high set points
the alarm will NOT activate.

Alarm Text
In this box enter the alarm message that will be displayed. Remember,
it can be up to 34 characters.

Alarm Screen ⇒⇒⇒⇒⇒
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Alarm Toolbar

Save
This button will save any additions or changes to the alarm screen.

Delete Alarm
This button will delete the selected alarm. To select an alarm simply
click once with the pointer tool on the line you wish to delete.

Discrete
This button selects a discrete alarm. You must enter the PGI monitor
address register/bit number (400/0) format and use the On and Off
buttons to select the alarm state.

Register
This button selects a register alarm. You must set the low and high
Register Set Points for the register. The alarm will activate when the
register value goes outside the set points.

On
The On button determines that the alarm will be displayed when the
address (reg/bit) is on.

Off
The Off button determines that the alarm will be displayed when the
address (reg/bit) is off.

Attributes
The Attributes button brings up a dialog box entitled “Alarm” that
shows the following functions you can enable or disable for the current
alarm.

Attributes Dialog Box

Alarm Group
In the Alarm Attributes dialog box, you can use the Alarm Group field
to assign the alarm to a group. There are 10 possible groups of alarms,
ranging from group 0 to group 9. The purpose of alarm groups is to
reduce the amount of time the PGI 100 must spend monitoring alarms
that may not be important at a particular time. Group 0 is ALWAYS
monitored. If another group is selected, the PGI monitors Group 0

NOTE:
Remember that any
function included
on the Toolbar can
also be accessed
by using the Alarm
menu at the top of
the screen.
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PLUS the selected group. The PGI can monitor up to 100 alarms —
ensure that you do not have more than 100 alarms selected at one time.

If an alarm group is not selected, then the alarms in that group are NOT
monitored. They are NOT displayed, logged, printed or sent to slave.
The alarm history is only updated when an alarm turns from on to off
or from off to on. If Alarm 1 in Group 1 is not monitored when the first
input turns on, the event is not displayed, logged, etc. When Group 1 is
selected the PGI sees that the bit is ON and displays, prints, sends to
slave and logs the ON time as being active at the time the group was
selected, not the time the alarm was actually activated. If the group is
deselected, the alarm is “cleared” from the screen even if the alarm is
still active, but it will not be logged as being off.

If the group is not selected when the alarm turns off, the OFF time is
not logged because the PGI did not witness the ON to OFF transition.
Only if the group is selected at the time the alarm turns off will the PGI
log the off time. In other words, your history screen could have logged
alarms with the ON time but not the OFF time.

If the group is selected and the alarm turns on the second time, the
event is not logged because the alarm history already has an entry with
an ON time but no OFF time. When the input turns off a second time
and the alarm is being monitored, the event is used as the OFF time in
the alarm history. The alarm history performs this way to prevent
logging ON and OFF times when the unit is reset.

In summary, use Group 0 for alarms you want to log and that are high
priority. Use Groups 1–9 for lower priority alarms that do not need to
be logged.

Monitor Register Data Type
The data type of the registers the alarms are monitoring.

Display Alarm when triggered
This causes the alarm to be displayed when triggered.

Log Alarm when triggered
This causes the alarm to be logged in the Alarm History screen when-
ever it is triggered. The history screen will store up to 64 alarms and,
when the 65th comes in, will dump the oldest alarm.

NOTE:
Group 0 alarms are
monitored at all times.
If there are numerous
alarms programmed it
could slow the PGI to
PLC communication.
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Print Alarm when triggered
This prints the alarm message out the Aux port of the PGI every time it
is triggered.

Display Alarm History when triggered
This displays the alarm history screen when triggered.

Display Base Screen when triggered
This will display the Base Screen that has been entered when the alarm
is triggered.

Print Report when triggered
This will print the selected Report screen out the Aux port of the PGI
when the alarm has been triggered.

Read Register when triggered
This reads the specified PGI register when an alarm is triggered. You
must also select the data type of the register that is being read. The
value read may be viewed in the alarm history screen.

Send to slave when triggered
This will send the alarm out the Com Port of the PGI to a slave when
triggered. You must specify a Group and Unit number for the slave.

Save Defaults
Save Defaults allows you to customize the attributes selections and
then save them for future use.

Use Defaults
Use Defaults, when pressed, reverts back to the factory settings.

Report Screens
A report screen may contain text, numeric triggers, scaled numeric
triggers, bit text triggers, clock triggers, message screen triggers, and
text string triggers. When a report screen is being edited, all text and
triggers will snap to the grid, which will be set to the 1 x 1 character
size. Only 1 x 1 characters will be allowed.

Report screens can be displayed or printed. There are three ways to
print a report; by the Special Command Registers, when a report screen
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is being displayed on the PGI 100, or when an alarm is triggered.
When a report screen is displayed two buttons appear at the bottom of
the screen. One button allows you to print the report and one to return
to the previous base screen. A report screen can only be displayed two
ways, by a special command register or by a report trigger. The triggers
on the screen will not update while the screen is displayed.

Report Screen ⇒⇒⇒⇒⇒

Message Screens
Message Screens can be accessed by using the Screen menu, clicking
on Select, and choosing Messages. Messages are single lines of text,
up to 80 characters, that can be displayed on a PGI 100 base screen
using Message triggers or the Message object from the ToolBox.
Messages can be numbered from 1 to 999. To create a message simply
scroll to its numbered line on the screen and enter text into the text
field at the right side of the line.

Three attributes for each message can be chosen by using the check
boxes at the left side of the line. They are as follows:

LOG:   When this is checked and the message is displayed,
the time and date it was displayed will be stored in a message
log in the PGI 100.

PRINT:  When this is checked the message is displayed and
printed to the serial aux port of the PGI.

SEND SLAVE:  When this is checked and the message is
displayed, the text of the message will be sent to a PMD slave
connected to the PGI 100 Com 2 Serial Port. If SEND
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SLAVE is checked, the Attributes button should be used to
bring up the Attributes dialog box for the message. The group
and unit number of the slave must be specified in that dialog
box.

EXAMPLE:  Data Set in a Message Screen

— Temperature of oven is ^32040 degrees.

— In this example the message screen will read from the
register specified for Data Set 3 as a BCD number. It will
display a total of four characters and will pad the display with
leading zeros. When the message is called up in the example it
will also be saved in the message log.that dialog box.

There can be 80 characters per message, depending on the character
size you have selected for the Message trigger. If too large a character
size is selected, the complete message will not be viewable on the PGI.
In addition, the message may have variable data codes embedded in the
message. The embedded data codes consist of a sequence of characters
in the form “^VFDDP.”

Where: ^  signals the start of an embedded code. V  is the data set
number (1–4). F  0 – signed decimal, 1 – unsigned decimal, 2–
BCD, 3 – hexadecimal, and 4 – octal. DD is the number of
digits to display. If the number of digits  is less than 10, then
enter a leading 0 (an example would be “05”).  P  Pad with... 0
– leading zeros, 1 – leading spaces, 2 – trailing spaces.

Message Screen ⇒⇒⇒⇒⇒
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Save
This command saves the current screen.

Clear
This command allows you to delete all of the objects on the current
screen.

To clear the screen:
1. Click on the screen pulldown menu.

2. Click on the clear function.

Redraw
This command redraws the screen. This function is transparent and can
be performed at any time.

To redraw the screen:
1. Click on the screen pulldown menu.

2. Click on the redraw function.

Annotation
Screen annotation allows you to edit or add documentation to the
current screen.  See Annotation under “Project Setup.”

Copy Range
Copy range allows you to copy screens within the project. You must
copy like screens. For example, you must copy a base screen to a base
screen, or a library screen to a library screen.

Image type  Select the type of screen to be copied.
Start of Source This is the screen number of the first screen to be
copied.
End of Source  This is the screen number of the last screen of the
range to be copied.
Start of Destination  This is the screen number of the destination. All
screens copied within the group will be placed in order behind the
destination number.
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REMOTE MENU

The Remote menu contains functions that are only useful when a
remote project is open and uWIN is communicating with a PGI
100.

PLC Driver Upload
This uploads the driver for the selected PLC to the PGI 100. Click on
the arrow to select a PLC from the menu. Click on the select button to
begin uploading the PLC code to the PGI 100.

Remove
This removes the PLC code from the PGI 100.

Initialize
Initializing allows you to reset the
unit to factory presets and clear the
memory. An item marked with an X
in the box next to it will be initial-
ized.

About
The About command displays the current status of the PGI 100.  A
dialog box indicates pertinent hardware and software version informa-
tion.

Display Screen
This allows you to display a screen on the PGI 100.

To display a screen:

1.  Click on the Display Screen option
under the Remote Menu.

2.  From the Display Screen dialog box
select a screen to be displayed and click
on Select.
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Monitor Registers
This allows you to monitor and change the values of the PGI 100
registers. Up to 20 registers can be monitored at one time.

To monitor registers:
1. Select the Monitor Registers option from the Remote Menu.
2. You may enter register numbers in the table in the columns

labeled Address. The values for the registers will be dis-
played in the Value column. To change a register’s value
click on the value with the mouse and enter the new value.
The register will be changed when the enter key is pressed or
a different field is selected.

3. The Display format selects how the data will be displayed and
entered in the register.

Alarm History
The alarm history holds information on the last 64 alarms logged. The
information includes the time and date of the alarm and when it was
cleared, the value of a register specified by the alarm, and a high or low
indicator for alarms with high or low set points.  The alarm history can
be printed through the auxiliary port.

Message Log
When messages programmed in the PGI are displayed, the message
number displayed and the time it was displayed can be recorded in the
Message Log. A message will be entered into the log if its log message
check box was selected when it was programmed.

When selected, the function displays a dialog box that lists the mes-
sages in the form of a table. The date and time the message was dis-
played, the number of the message and the text of the message are
shown here. The user may use the scroll bar to view more messages in
the log. The Print Log button will send the contents of the log to the
printer, while the Clear Log button allows the user to clear the message
log.

Time and Date
The Time and Date option allows you to set the time and date in the
PGI 100. A dialog box containing the PGI 100’s clock time and your
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computer’s clock time is displayed. Either the PC time and date or an
edited time and date can be sent to the PGI. Time values can be entered
in 12- or 24-hour format.

User Flash Program
When you open and edit a remote project in the PGI 100, all operations
are performed on a copy of the project that the PGI keeps in its RAM
user memory. Some models of the PGI 100 can be equipped with flash
user memory as well. When a flash equipped unit powers up or is
restarted, it copies the project from flash memory into the RAM
memory. If you make changes to the project in RAM memory, you
must use this function to copy the project to the flash memory.

Recall
This function copies the remote project from the Flash memory into
user RAM memory. The project in user RAM memory will be over-
written.

Send Text
This option allows you to send a text message to be displayed on the
PGI 100.  The message remains on the screen until a new screen is
displayed.  The Send Text dialog box allows you to enter a message, its
screen location, color, size and direction. Once the message is com-
plete, click onto Send and the message will be displayed on the PGI
with the selected attributes.

Warm Start
A Warm Start performs the same function as a restart with the excep-
tion that the self-tests will not run and if there is flash user memory, it
will not be copied to RAM.

Memory Test
An important function, the Memory Test option tests the user RAM
memory. In addition, if the PGI 100 has flash user memory, it is also
tested. If the PGI 100 does not have flash memory the user memory is
cleared. If the PGI has flash memory the program in flash memory is
copied to user memory. The flash memory is also tested, but the pro-
gram stored in it is retained.
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HELP MENU

Help on Help
This function provides help on windows help functions and how to
navigate through windows help.

Index
This function brings up the uWIN online help system. One of the most
important features of the PGI software is the availability of onscreen
help.

To access the help windows you can select Index or simply press the
F1 function key and you can access associated help screens anytime
while using the software.

About
This function is useful if you need to view information such as the
name, address and phone number of UTICOR, or the part number,
registration information, revision number and the date of the revision of
the uWIN software.
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This addendum provides you with information on features of the uWIN Software used to
program your PowerPanel that are not covered in the manual.

The features or changes mentioned below are not in this revision (P/N 79769-3) of the
manual, although you will find them in your uWIN’s extensive online HELP.

Look for these differences between the manual and what you will see when you have
uWIN running:

1  Name Change
You will notice that the PGI
100 Series is now called the
“PowerPanel” Series .

We’ve simplified our
descriptions of the different
display types.  To avoid
confusion — refer to the
table to the right for the
description changes.  Also,
in this table, you will notice
that an 8" Color Model is
now available.

2  “Busy Message”
“Busy” Message  — When you are switching screens, you will receive a “Busy”
message on your display to indicate that your PowerPanel is “busy” working on the
screen switch.  On your System Attributes dialog box under the “General” tab you
may choose to enable or disable this message. See figure, below.

3  Multiple Language Support Feature

Multiple Language Support feature  —  Today, many production personnel do not
speak English as a first language.  Companies are finding that they can convey
information to these operators faster, and with less confusion, when it is in the
operator’s native language.  uWIN enables you to enter display messages in
several different languages (as long as the character set for that language con-
forms to the standard ASCII-based English character set) that can then be
switched to accommodate the personnel on a particular shift.

1
— continued

Old Dis play Type Descri ption New Dis play Type Descri ption

PGI 100 4" Monochrome LCD PowerPanel 5" Monochrome LCD

--- PowerPanel 5" Monochrome with Backlight

PGI 100 5.1" Active Matrix Color PowerPanel 5" Active Color

PGI 100 5.1" STN Color PowerPanel 5" Passive Color

PGI 100 5.6" Monochrome LCD PowerPanel 6" Monochrome LCD

--- PowerPanel 8" Passive Color

PGI 100 9" Monochrome EL PowerPanel 9" Monochrome EL

PGI 100 10.4" Color EL PowerPanel 10.4" EL Color

PGI 100 10.4" Color LCD PowerPanel 10.4" Active Color

PGI 100 10.4" STN Color PowerPanel 10.4" Passive Color

Select yes here to enable
Busy Message

Select “Default” language
here
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This is not to say that uWIN translates the English-language phrases into other
languages —it only recognizes strings of ASCII characters and then only those found in
the ASCII-based American English character set.  But, because you can enter different
ASCII-character-based text strings, you can create messages that convey meanings in
other languages.  Up to 16 text strings can be created for each object.  So, you could
implement a pushbutton to say:  “HELLO” for English-speaking operators; “HOLA” for
Spanish-speaking opeators, “GUTEN TAG” for German-speaking operators, etc.

The Multiple Language Support feature is offered in the following uWIN ToolBox
objects:

ASCII String Object, Bar Graph Object, Alarm History Button, Numeric Entry
Button, Push Button, Indicator Button, Change Screen Button, Recipe Button,
Report Screen Button, Step Switch Button, Label Object, Numeric Object, Pilot
Light Object

and the following screens/triggers/tools:

Bit Text Trigger, Multi-line Text, Alarm Screen, Message Screen, Alarm History
Screen, and Message Log.

uWIN allows you to program up to 16 different “languages” for a ToolBox Object text
string, and then, in System Attributes, select the “Default Language” required for a
particular application.

The Default Language is the language used by the PowerPanel on power-up.  To
switch languages use Special Commands 101 through 116.  (See Special Com-
mands under System Attributes in your uWIN programming software.) Please be
aware that the text displayed on the PowerPanel will not change to the new lan-
guage until you switch screens or REDISPLAY the current screen.

 An example for programming 2 alternate languages for a Push Button Object follows.
It is important to keep in mind that uWIN does not interpret or translate English into
any foreign language and only recognizes ASCII text string characters.  uWIN and
the PowerPanel will display exactly what you have typed into the text box for that
object — you provide the “language.”

Language Preference allows you to select and view different versions of text strings
while you are working in uWIN.   Each version can be created for a different language
(up to 16) for each object where text is displayed.  For instance, for the Push Button
Object, if you want the text within the button to say “Hello” in Language Number 1,
“HOLA” (Spanish equivalent ) in Language Number 2, and “GUTEN TAG” (German
equivalent) in Language Number 3, do the following:

1. Select the Push Button Object from the ToolBox or Main Menu and place it on
your Base Screen.

2. A dialog box will appear, click on the Label tab at the top.

3. In the Language Number box type in “1”,  then type “HELLO” in the text box.  Go
back to Language Number box and type in “2”, then type “HOLA” in the text box,
and repeat for “3” and “GUTEN TAG.”

4. Click on OK.

5. The next time you type in Language Number 1, 2 or 3, the corresponding text
string will come up in the text box.

— continued
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6. To view the different languages for the Push Button Object text, click on Options
on the Main Menu Bar and select Preferences > Language and then enter the
“working” Language Number that you want to view in uWIN.  The text in your
Push Button Object will change accordingly.  Keep in mind that this is for viewing
while working in uWIN only.  To set the Language preference that will be
displayed on the PowerPanel, you must select the Language Number as the
Default Language while programming your System Attributes.

You may create up to 16 text strings  for each object.  If you select a language in the
Options> Preferences>Language dialog box for which there is no text string for an
object, it will default to and display the text in Language Number 1.  Keep in mind that
the total size of any object command is 255 bytes and each character in a text string
uses 1 byte.  This means that you must keep your total message characters for an
object to approximately 200.(See page  , for more information)

4 Enable Feedback

This feature has been added to 5 of the buttons:  Indicator Pushbutton, Pushbutton,
Register Button, Recipe Button and the Step Switch Button. (It is an available option
only when you are in the “Advanced Level” programming mode.  The checkbox is
grayed out and unselectable, when you program in the “Basic Level” programming
mode.) Please note that Enable Feedback, when selected, slows down the screen
refresh time noticeably — so consideration should be given to your particular applica-
tion requirements before choosing this option. When you create any of the five buttons
mentioned above, you can check this option for visual feedback — the operator pushes
the button and the outline switches colors to indicate that it has been activated.

5 Modem Option

Under Options on the main menu you can now “hookup” to a modem and access your
PowerPanel from just about anywhere at anytime!

6 Screen Security Codes

We’ve “stepped up security” for your screens and made this feature much more
versatile. Eight security codes have been implemented instead of just one.  The
Change Screen Button and the Display Screen Trigger now have eight check boxes to
select which security codes will allow access to the screen.  Multiple security codes
may be checked.  Any security code that is checked will allow access to the screen —
you do not need the highest security code nor do you need all of the security codes.  In
addition, the registers that hold the security codes may be modified to allow the user to
change security codes while using the PowerPanel.

7 uWIN Registration

You no longer need to register your uWIN software.  Please disregard any references to
entering the registration number on the inside cover of the uWIN manual.

8 Cyrillic Characters

Now, in addition to ASCII characters, your PowerPanel can be programmed to display
Cyrillic characters.

— continued
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Follow the instructions in uWIN Help, or use the steps and table shown to the left.

Cyrillic characters may be used as text in any object or trigger in the PowerPanel and
uWIN.  A number of the Cyrillic characters are common to the ASCII character set.
These characters may be entered by pressing the corresponding ASCII key on your
keyboard.  These characters are:

A B E K M H
O P C T X

To enter the non-ASCII characters, you must use the ALT key and the numeric
keypad on your keyboard.  While holding down the ALT key, type in the code for
the desired character as shown in the table.  Note that the first digit must be a
zero.  If it is not, then an undefined character will be entered.

The Cyrillic characters that are available are included in the table to the left.

Remember —  uWIN HELP is “up-to-date” and ready to help  you  program your
PowerPanel — with all the new features and changes mentioned above.

9 File Conversion

Are you using revision E.2 of uWIN?

With revision E.2 of  uWIN, project files that
you have created on previous versions of
uWIN must be converted in order to work.
A “Confirm file conversion” message
window will appear that asks you whether
to proceed with the conversion (click OK)
or Cancel the action.  PLEASE BE AWARE
that once your project files have been
opened/converted in this version of uWIN,
they will not work in previous versions!  If
you need them to work with previous
versions of uWIN, do not convert the files.

10 Bitmap Screen

The bitmap screen allows you to draw bit images and/or import bitmap files into the
screen. These images can represent motors, pumps, valves  — just about anything.
You can import a bitmap file into the screen or image.  This can be useful when you
have created a bitmap in another program and would like to use it to enhance the
visual impact of your PowerPanel screen.

— continued
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Bitmaps can be up to 64K bytes. For the best possible performance when working with
bitmaps, it is recommended that your programming computer use a 233 MHz (or
faster) Pentium Processor. You may still use uWIN’s bitmap screen feature with a 486,
but the screen “refresh” time will be significantly slower.

The Status Bar appears at the bottom of the Bitmap screen.  In the figure below, the
features circled in red are the only active elements for the Bitmap screen.  The two
color bars allow you to select the left and right mouse button colors.  The “Free” shows
you how many bytes of memory remain free (this status only updates after you have
saved the bitmap.)

Bitmaps can range in size from 8 x 8 to 640 x 480 pixels.  If the size is 96 x 96 or less,
the bitmap is displayed on a grid similar to that used in a Symbol screen.  It is also
shown in actual size in the upper right of your screen.  You can edit the bitmap by
clicking the left and right mouse buttons on the grid.  The left mouse button uses the fill
pattern foreground color and the right mouse button uses the fill pattern background
color.

If the size of the bitmap is greater than 96 x 96, then the grid is not displayed.  The
bitmap is displayed in actual size and you cannot edit the bitmap.

Bitmap files (.bmp) can be imported into a bitmap screen.  When a bitmap is imported,
the colors are converted to the current palette settings.  Colors are not converted to
blinking colors.  (Note that the default palette only has 8 non-blinking colors.)

Bitmaps can be exported if they are 96 x 96 pixels in dimension, or less.

Bitmaps can be resized.  Click on “Bitmap” in the Main Menu Bar, and then select
“Dimensions.” You may also click on the last button in the tool bar.  A dialog box will
appear allowing you to enter the new dimensions.  When the bitmap is expanded the
“new” area is black.  When it is made smaller, the outer area is discarded.

You may clear a bitmap to the left mouse color.  Bitmaps can only be included in base
screens.  You cannot use them in objects or triggers.

Creating or Importing a Bitmap;

1. From the Screen  menu, click on Select  and choose Bitmap .

2. Enter a new screen number and title, click on Select .

3. Bitmaps are drawn on a pixel by pixel basis. They can be dimensional from a
size of 8 columns by 2 rows up to 96 columns by 96 rows. Column dimensions
must be divisible by 8 and row dimensions divisible by 2. You can resize the
bitmap by choosing Dimensions  from the Bitmap  Menu.  Bitmaps larger than 96
x 96 will be displayed in actual size (no grid will appear) and you cannot edit
them.

4. The bitmap grid dimensions default to 48 x 32.

5

— continued



           79769-3_A7

uWIN Software Manual Addendum

5. To create a bitmap, hold down the left or right mouse button in the grid. As you
move the mouse across the screen each pixel becomes colored according to
the color selected for the left or right mouse. If you need to delete a colored grid,
select the background color, place your cursor on that particular grid and click
the right mouse button. The color will change to the background color you have
selected.

6. While you are creating your bitmap it appears in its actual size in the upper right
corner of the screen.

7. When you are done creating the bitmap, click on Save Screen to save it to your
file.

8. Located under the Bitmap  Menu are selections to import and export bitmap
images. To import an image, choose Import  Bitmap , then select the drive and
directory where the file is located. Select the correct file name and click OK.
Images larger than 96 x 96 can be imported, but you will not be able to edit
them. To export a bitmap, click on Export  Bitmap , name the bitmap file, and
select the directory to export it to. Click OK.  Note:  Only bitmaps 96 x 96 or less
may be exported.

BITMAP DIMENSIONS

Bitmaps are drawn on a pixel by pixel basis. They can be dimensional from a size of 8
columns by 8 rows up to 640 columns by 480 rows. Column dimensions must be
divisible by 8 and row dimensions divisible by 2. You can resize the bitmap by choosing
Dimensions  from the Bitmap  Menu.  Bitmaps larger than 96 x 96 will be displayed in
actual size (no grid will appear) and you cannot edit them.

1. Enter a number from 8 to 640 in the box next to Bitmap Columns .
2. Enter a number from 8 to 480 in the box next to Bitmap Rows .
3. Click OK to save or Cancel to exit dialog box.

6



NOTES

5



UTICOR Technology, LP
AVG Automation
4140 Utica Ridge Road
P.O. Box 1327
Bettendorf, IA 52722-1327


	uWIN_A7.pdf
	TOC
	1 Name Change
	2 "Busy Message"
	3 Multiple Language Support Feature
	4 Enable Feedback
	5 Modem Option
	6 Screen Security Codes
	7 uWIN Registration
	8 Cyrillic Characters
	9 File Conversion
	10 Bitmap Screen

	uWIN_A7.pdf
	TOC
	1 Name Change
	2 "Busy Message"
	3 Multiple Language Support Feature
	4 Enable Feedback
	5 Modem Option
	6 Screen Security Codes
	7 uWIN Registration
	8 Cyrillic Characters
	9 File Conversion
	10 Bitmap Screen


